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About this guide

This section includes these topics:

e  What this guide covers (page 2)

e Conventions used in this guide (page 3)

e About the BD LSRFortessa documentation (page 3)

e Technical assistance (page 7)
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What this guide covers

This guide describes the procedures necessary to operate and
maintain your BD LSRFortessa™ cell analyzer. Because
many cytometer functions are controlled by BD FACSDiva™
software, this guide also contains information about
software features required for basic cytometer setup and
operation.

This guide assumes you have a working knowledge of basic
Microsoft® Windows® operation. If you are not familiar
with the Windows operating system, see the documentation
provided with your computer.
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Conventions used in this guide

About this topic This topic describes the conventions used throughout this
guide.
Safety symbols These safety symbols are used in this guide and on safety

labels to alert you to potential hazards.

Meaning
Caution alert

Identifies a hazard or unsafe practice that could
result in data loss, material damage, minor injury,
severe injury, or death

Biological hazard

Electrical hazard

Laser hazard

Hot surface; High temperatures; Burn hazard

> B> B
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Text and keyboard
conventions

Convention

Notes

Bold

Italics

Ctrl+X

Use

A note describes important features or
instructions.

Bold is used to indicate software elements
such as dialogs, fields, and buttons.

Ttalics are used to highlight book titles.

Italics are also used in describing software
to indicate specific text typed into a
window or dialog.

The arrow is used to indicate menu
selection paths. For example, “Select
File > Print” means to select the Print
option from the File menu.

When used with key names, a plus sign (+)
means to press two keys simultaneously.
For example, Ctrl+P means to hold down
the Control key while pressing the p key.
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About the BD LSRFortessa documentation

About this topic This topic describes the documentation available with the
BD LSRFortessa flow cytometer.

Publication formats This guide is provided in PDF format to provide an
eco-friendly option. All content is also included in the
BD FACSDiva software Help.

Online help The online help installed with BD FACSDiva software
includes all content from this guide and the documents listed
below. Access BD LSRFortessa online help from the Help
menu in BD FACSDiva software.

The online help is compiled from the following documents:

e BD FACSDiva Software Reference Manual: Includes
instructions or descriptions for installation and setup,
workspace components, acquisition controls, analysis
tools, and data management. Access this manual from
the BD FACSDiva Software Help menu (Help >
Literature > Reference Manual), or by double-clicking
the shortcut on the desktop.

e BD Cytometer Setup and Tracking Application Guide:
Describes how to use the Cytometer Setup and Tracking
features in BD FACSDiva software.

e BD LSRFortessa Cell Analyzer Site Preparation Guide:
Contains specifications for:

— Cytometer weight and size
— Temperature and other environmental requirements

— Electrical requirements
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e  BD High Throughput Sampler User’s Guide: Describes
how to set up and operate the BD™ High Throughput
Sampler (HTS) option. It also contains a description of
BD FACSDiva software features specific to the HTS.

e BD FACSFlow Supply System User’s Guide: Describes
the optional automated sheath and waste fluid control
system designed for use with the BD™ LSR II and
BD LSRFortessa.
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Technical assistance

About this topic This topic describes how to get technical assistance.

Getting assistance from  For technical questions or assistance in solving a problem:
this guide
e Read the sections of the documentation specific to the
operation you are performing. See About the
BD LSRFortessa documentation (page 5) for more
information.

e See Troubleshooting (page 115).

Contacting technical If additional assistance is required, contact your local
support BD Biosciences customer support representative or supplier.

When contacting BD Biosciences, have the following
information available:

e Product name, part number, and serial number
e Version of BD FACSDiva software you are using
e Any error messages

e Details of recent system performance

For cytometer support from within the US, call
877.232.8995.

For support from within Canada, call 888.259.0187.

Customers outside the US and Canada, contact your local
BD representative or distributor.




Need more information fast?

Information about this product is also available in your
software's Help system.

You can keep the Help window open while you use the
software or print the information directly from the window.

Internet access is not required to use the Help system.




Introduction

The following topics are covered in this section:

Instrument overview (page 10)
Components (page 11)

Fluidics (page 13)

Sheath and waste containers (page 17)
Optics (page 18)

Workstation (page 21)
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Instrument overview

The BD LSRFortessa is an air-cooled multi-laser benchtop
flow cytometer with the ability to acquire parameters for a
large number of colors. It uses fixed-alignment lasers that
transmit light through a flow cell to configurable octagon
and trigon detector arrays. These detectors collect and
translate the resulting fluorescence signals into electronic
signals. Cytometer electronics convert these signals into
digital data.
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Components

About this topic This topic describes the instrument’s components.

Instrument overview

| Heat ventilation slots

Power switch (right side)

RFortessa

©BD LS Sample injection port (SIP)

Front doors (trigon detector
arrays)

Side drawer (octagon or trigon Control panel
detector arrays)

Caution! Do not place any objects on top of the instrument.
A Blocking the ventilation may cause the instrument to
overheat.

Caution: Electrical Hazard! Do not place liquids on top of the
A A instrument. Any spill of liquid into the ventilation openings

could cause electrical shock or damage to the instrument.
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Power switch The power switch is located on the right side of the
instrument.
Control panel The control panel contains the following fluidics controls:

e Sample flow rate control buttons
e  Fluid control buttons

e Sample fine adjust knob

SAMPLE
FINE ADJ

@ < © o

Sample flow rate control buttons Fluid control buttons

Related topics e  Fluidics (page 13)

e  Optics (page 18)
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About this topic

Purpose

Sample flow rate control

This topic describes the fluidics system.

The purpose of the fluidics system is to carry the sample out
of the sample tube and into the sensing region of the flow
cell. Cells are carried in the sample core stream in single file
and measured individually.

Three flow rate control buttons (LO, MED, and HI) set the
sample flow rate through the flow cell. The SAMPLE FINE
AD]J knob allows you to adjust the rate to intermediate
levels.

When the SAMPLE FINE AD]J knob is at its midpoint, the
sample flow rates at the LO, MED, and HI settings are
approximately 12, 35, and 60 pL/min of sample, respectively.
The knob turns five full revolutions in either direction from
its midpoint, providing sample flow rates from 0.5-2X the
midpoint value. For example, if the LO button is pressed, the
knob will give flow rates from approximately 6-24 pL/min.
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Fluid control

Three fluid control buttons (RUN, STNDBY, and PRIME)
set the cytometer mode.

RUN. Pressurizes the sample tube to transport the
sample through the sample injection tube and into the
flow cell.

The RUN button is green when the sample tube is on
and the support arm is centered. When the tube support
arm is moved left or right to remove a sample tube, the
cytometer switches to an automatic standby status to
conserve sheath fluid, and the RUN button changes to
orange.

STNDBY (standby). Stops fluid flow to conserve sheath
fluid.

When you leave the cytometer for more than a few
minutes, place a tube containing 1 mL of deionized (DI)

water on the sample injection port (SIP) and press
STNDBY.

PRIME. Prepares the fluidics system by draining and
filling the flow cell with sheath fluid.

The fluid flow initially stops and pressure is reversed to
force fluid out of the flow cell and into the waste
container. After a preset time, the flow cell fills with
sheath fluid at a controlled rate to prevent bubble
formation or entrapment. At completion, the cytometer
switches to standby mode.



Sample injection port
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The SIP is where the sample tube is installed. The SIP
includes the sample injection tube and the tube support arm.
Samples are introduced through a stainless steel injection
tube equipped with an outer droplet containment sleeve. The
sleeve works in conjunction with a vacuum pump to
eliminate droplet formation of sheath fluid as it backflushes
from the sample injection tube.

Outer sleeve

Sample injection tube

Tube support arm

e Sample injection tube. Stainless steel tube that carries
sample from the sample tube to the flow cell. This tube is
covered with an outer sleeve that serves as part of the
droplet containment system.

e Tube support arm. Arm that supports the sample tube
and activates the droplet containment system vacuum.
The vacuum is on when the arm is positioned to the side
and off when the arm is centered.

Note: If a sample tube is left on the SIP with the tube
support arm to the side (vacuum on), the sample will be
aspirated into the waste container.
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Cautions when using the
HTS option

A A

A
A

Droplet containment
module

Caution: Biohazard! When using the BD LSRFortessa
cytometer with the BD High Throughput Sampler (HTS),
ensure that the HTS is completely pushed into the operating
position before removing the DCM (droplet containment
module) sleeve or disconnecting the sample coupler from the
SIP. This is to avoid accidental leakage of potentially
biohazardous liquids directly onto the instrument. With the
HTS in the proper location, the containment dish with
padding is directly below the SIP.

Caution! If you are using the HTS option, always slide the
HTS mount slowly to prevent sample cross-contamination
when the wells are full. Never move the HTS when it is in
operation.

Caution! Do not lean on or put any weight on the HTS as it
could damage the instrument.

The DCM prevents sheath fluid from dripping from the SIP
and provides biohazard protection.

When no sample tube is installed on the SIP, sheath fluid
backflushes through the sample injection tube. This
backflush helps prevent carryover of cells between samples.
The DCM vacuum is activated when the sample tube is
removed and the tube support arm is moved to the side.
Sheath fluid is aspirated as it backflushes the sample
injection tube.
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Sheath and waste containers

About this topic This topic describes the sheath and waste containers. The
sheath and waste containers are outside the cytometer and
are positioned on the floor.

Note: If your system is using the BD FACSFlow™ supply
system, please see the documentation provided with your
system.

Sheath container The sheath container has a capacity of 8 L. Sheath fluid is
filtered through an in-line, interchangeable filter that
prevents small particles from entering the sheath fluid lines.

capacity (8 L). When an overfull tank is pressurized, erratic
cytometer performance can result.

2 Caution! Do not fill the sheath tank to its maximum

Waste container The waste container has a capacity of 10 L. An alarm sounds
when the container becomes full.

Related topics e Preparing the sheath container (page 26)

e Preparing the waste container (page 30)




18 | BD LSRFortessa Cell Analyzer User's Guide

Optics

About this topic This topic describes the optical components for the
BD LSRFortessa cytometer including;:

o Detector arrays
e Laser options
e Optical filters

e Signal detectors

Detector arrays The BD LSRFortessa detector arrays consist of:

e Octagons. Array of PMTs and filters that can detect up
to eight signals.

e Trigons. Array of PMTs and filters that can detect up to
three signals.

Locked cover (lasers
accessible by BD Service only)

BD LsRFonessa

Front door panels (trigons)

Side drawer (octagons or trigons)
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Laser options The BD LSRFortessa flow cytometer can be configured with
up to four lasers listed in the following table. The cytometer
can also be upgraded with lasers from this list, or configured
with up to five lasers from a variety of wavelengths through
our Special Order Research Program.

Laser Wavelength (nm) Power (mW)
Blue 488 50
Red 640 40
Violet 405 50
uv 355 20
Optical filters Optical filters attenuate light or help direct it to the

appropriate detectors. The name and spectral characteristics
of each filter appear on its holder.

There are two types of optical filters in the BD LSRFortessa:

e Longpass dichroic filters (LPs). Transmit wavelengths
that are longer than the specified value and reflect all
light below the specified wavelength.

e Bandpass filters (BPs). Pass a narrow spectral band of
light.

When dichroic filters are used as steering optics to direct
different color light signals to different detectors, they are
called dichroic mirrors. LP dichroic mirrors transmit longer
wavelengths to one detector while reflecting shorter
wavelengths to a different detector.
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Signal detectors

The BD LSRFortessa cytometer octagon and trigon detector
arrays use dichroic longpass mirrors on their inner rings, and
bandpass filters on their outer rings. You can customize the
arrays with other wavelengths of filters and mirrors.

Bandpass filters

Longpass dichroic
mirrors

Light signals are generated as particles pass through the laser
beam in a fluid stream. When these optical signals reach a
detector, electrical pulses are created that are then processed
by the electronics system.

There are two types of signal detectors in the
BD LSRFortessa flow cytometer:

e Photomultiplier tubes (PMTs). Used to detect the
weaker signals generated by side scatter and all
fluorescence channels. These signals are amplified by
applying a voltage to the PMTs.

e Photodiodes. Less sensitive to light signals than the
PMTs. A photodiode is used to detect the stronger
forward scatter (FSC) signal. However, an optional PMT
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for detecting FSC is available through the BD Special
Order Research Program.

Related topics e Optical filter theory (page 103)
e About the base configuration (page 133)

e Special Order configurations (page 149)

Workstation

About this topic This topic describes the components of the BD LSRFortessa
workstation.

Workstation components Acquisition, analysis, and most instrument functions are
controlled by the BD LSRFortessa workstation. It includes a
PC, one or two monitors, and a printer.

Your workstation is equipped with the following:

e Microsoft Windows operating system

e BD FACSDiva software version 6.2 or later for data
acquisition and analysis

e Software documentation including an online help system

Related topics e About the BD LSRFortessa documentation (page 3)




Need more information fast?

Information about this product is also available in your
software's Help system.

You can keep the Help window open while you use the
software or print the information directly from the window.

Internet access is not required to use the Help system.




Cytometer setup

This section includes the following topics:

Starting the cytometer and computer (page 24)
Preparing the sheath container (page 26)
Removing air bubbles (page 28)

Preparing the waste container (page 30)
Priming the fluidics (page 33)

About the optical filters and mirrors (page 34)
Changing optical filters and mirrors (page 36)

Custom configurations and baselines (page 37)
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Starting the cytometer and computer

About this topic

Procedure

This topic describes how to start the cytometer and turn on
the computer.

To start the cytometer:

1.

Turn on the power to the flow cytometer.

Note: If your system is using the BD FACSFlow supply
system, make sure that the BD FACSFlow supply system
is powered on before the cytometer.

Allow 30 minutes for the optical system temperature to
stabilize.

Caution! Failure to warm up and stabilize the
instrument could affect sample data.

Turn on the computer and log in to Windows.

Note: You can turn on the power to the flow cytometer
and the workstation in any order.

Start BD FACSDiva software by double-clicking the
shortcut on the desktop, and log in to the software.
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Check the Cytometer window in BD FACSDiva software
to ensure that the cytometer is connected to the
workstation.

The cytometer connects automatically. While connecting,
the message Cytometer Connecting is displayed in the
status area of the Cytometer window. When connection
completes, the message changes to Cytometer
Connected.

Cytometer - LSRFortessa (1)

Time: Event

‘Cytometer Connected 5

If the message Cytometer Disconnected appears, see
Electronics troubleshooting (page 127).
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Preparing the sheath container

About this topic This topic describes how to prepare the sheath container.

Note: If your system is using the BD FACSFlow supply
system, please see the documentation provided with your
system.

When to check the sheath Check the fluid levels in the sheath container every time you

container

use the cytometer. This ensures that you do not run out of
sheath fluid during an experiment.

Sheath container

components
Clamp knob
Cap handle Air line (green)
Tank handle

Vent valve

Sheath fluid line (blue)
(to cytometer)

Filter assembly
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Procedure To prepare the sheath container:

1. Verify that the flow cytometer is in standby mode.

Press the STNDBY button on the control panel if
necessary.

2. Disconnect the air line (green) from the sheath container.

3. Depressurize the sheath container by pulling up on the
vent valve.

4. Remove the sheath container lid.

Unscrew the clamp knob and push down to loosen, if
necessary. Tilt the cap to the side to remove it from the
tank.

5. Add 6 L of sheath fluid, such as BD FACSFlow solution,
to the sheath container.

Caution! Do not fill the sheath tank to its maximum
A capacity (8 L). When an overfull tank is pressurized,
erratic cytometer performance can result.
6. Replace the sheath container lid.
7. Reconnect the air line (green).

8. Make sure the gasket on the inside lip of the sheath lid is
seated correctly and has not slipped out of position.

If the gasket is not seated correctly, the tank will not
pressurize properly.

9. Close the sheath lid and tighten the clamp knob to
finger-tight. Ensure that the sheath fluid line (blue) is not
kinked.
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Related topics e Removing air bubbles (page 28)

e Changing the sheath filter (page 50)

Removing air bubbles

About this topic This topic describes how to remove trapped air bubbles in
the sheath filter and the sheath line. Air bubbles can
occasionally dislodge and pass through the flow cell,
resulting in inaccurate data.

Procedure To remove air bubbles:
1. Check the sheath filter for trapped air bubbles.

Cytometer fluid line
(roller clamp not visible)

Vent fitting

Vent line
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If bubbles are visible, gently tap the filter body with your
fingers to dislodge the bubbles and force them to the top.

Note: When removing air bubbles, do not vigorously
shake, bend, or rattle the sheath filter or you might
damage it.

Direct the vent line into a beaker and press the small
button at the end of the vent fitting against the side of
the beaker until a steady stream of fluid empties from the
filter.

Press small button

Vent fitting

Tilt the filter and verify that no trapped air remains in
the filter. Repeat steps 3 and 4 until no air is observed in
the filter.

Check the sheath line for air bubbles.

Open the roller clamp at the fluidics interconnect (if
necessary) to bleed off any air in the line. Collect any
excess fluid in a waste container.

Close the roller clamp.
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Preparing the waste container

About this topic

A A

When to check the waste
container

This topic describes how to prepare the waste container.

Note: If your system is using the BD FACSFlow supply
system, please see the documentation provided with your
system.

Caution: Biohazard! All biological specimens and materials
coming into contact with them are considered biohazardous.
Handle as if capable of transmitting infection. Dispose of
waste using proper precautions and in accordance with local
regulations. Never pipette by mouth. Wear suitable
protective clothing, eyewear, and gloves.

Check the fluid levels in the waste container every time you
use the cytometer. This ensures that the waste container does
not become too full.
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Waste container

components
/\ Waste tubing (orange) from
cytometer
Waste air vent filter
Level sensor line
Bracket
Cautions

Caution: Biohazard! To avoid leakage of biohazardous waste,
A @ put the cytometer in standby mode before disconnecting the

waste container.

Caution: Biohazard! The waste container contents might be

biohazardous. Treat contents with bleach (10% of total
volume).



32 | BD LSRFortessa Cell Analyzer User's Guide

Procedure

A\

Caution! If the air vent filter on the top of the waste
container cap assembly becomes clogged, air cannot be
vented from the container, causing it to swell under
pressure. If you observe swelling of the waste container,
loosen the cap to relieve the pressure, and immediately
replace the air filter. See Replacing the waste air filter
(page 49) for instructions. Removing the air filter or the
waste container cap assembly without first relieving the
pressure might generate an unnoticeable aerosol. Use
appropriate precautions when troubleshooting a clogged air
filter. Wear suitable protective clothing, eyewear, and
gloves.

To prepare the waste container:

1.

Verify that the flow cytometer is in standby mode.

Press the STNDBY button on the control panel if
necessary.

Disconnect the orange waste tubing and the black level
sensor line from the waste container. Keep the lid on the
waste container until you are ready to empty it.

Empty the waste container.

Caution! The waste container is heavy when full. When
emptying it, use good body mechanics to prevent
injury.

Add approximately 1 L of bleach to the waste container
and close it.

Reconnect the orange waste tubing and make sure it is
not kinked.

Reconnect the level sensor line.
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Priming the fluidics

About this topic This topic describes how to prime the fluidics system.
When to prime the Sometimes, air bubbles and debris may become lodged in the
fluidics flow cell. This is indicated by excessive noise in the forward

and side scatter parameters. In these cases, it is necessary to
prime the fluidics system.

Procedure To prime the fluidics:

1. Move the tube support arm to the side.
2. Remove the tube from the SIP.

3. Press the PRIME fluid control button to force the fluid
out of the flow cell and into the waste container.

Once drained, the flow cell automatically fills with
sheath fluid at a controlled rate to prevent bubble
formation or entrapment. The STNDBY button turns
amber after completion.

4. Repeat the priming procedure, if necessary.

5. Install a 12 x 75-mm tube with 1 mL of DI water on the
SIP and place the support arm under the tube. Leave the
cytometer in standby mode.

Related topics e Cytometer troubleshooting (page 116)
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About the optical filters and mirrors

About this topic

Filter and mirror
configurations

This topic provides a description of the optical filters and
Mmirrors.

Each PMT (except the last PMT in every detector array) has
two slots in front of it: a filter slot and a mirror slot.

o c)

Filter slot

Mirror slot \ f//@

e Filter slot. The slot closer to the PMT that holds a
bandpass filter holder.

e  Mirror slot. The slot farther from the PMT that holds a
longpass dichroic mirror holder.

The filters steer progressively shorter wavelengths of light to
the next PMT in the array starting at PMT A.



Optic holders, filters, and
mirrors

Base configurations

BD FACSDiva cytometer
configuration

Related topics
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Optic holders house filters and mirrors. Your cytometer
includes several blank (empty) optic holders.

Note: To ensure data integrity, do not leave any slots empty
in a detector array when you are using the associated laser.
Always use a blank optic holder.

Each BD LSRFortessa cytometer has a base cytometer
configuration that corresponds to the layout of the installed
lasers and optics in your cytometer. This base configuration
is set by your field service engineer.

Before you acquire data using BD FACSDiva software, you
must specify a cytometer configuration. The cytometer
configuration defines which filters and mirrors are installed
at each detector.

BD FACSDiva software provides a BD base configuration for
your BD LSRFortessa cytometer. Select Cytometer >

View Configuration to create, modify, or delete custom
cytometer configurations. (See the Cytometer and
Acquisition Controls chapter of the BD FACSDiva Software
Reference Manual for details.)

e Changing optical filters and mirrors (page 36)
e About the base configuration (page 133)

e Special Order configurations (page 149)
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Changing optical filters and mirrors

About this topic

A A

Procedure

Related topics

This topic describes how to verify that the optical filters are
in the appropriate position for your particular requirements.
Before you run samples, you must set up the optical filters.

Caution: Laser Hazard! Follow the precautions outlined in
the BD LSRFortessa Safety and Limitations Guide while
changing optical filters or mirrors.

To change a filter or mirror:
1. Access the appropriate detector array.

— Octagon or trigon arrays are located in the left side
cytometer drawer.

— Up to two trigon arrays are located in the front
doors.

2. Remove the appropriate filter holder or mirror holder.

3. Replace the removed holder with the new filter or mirror

holder.

The metal ring on the filter or mirror holder must face
toward the center of the trigon or octagon. Verify that
the filters are arranged so that the longest wavelength is
in the A position and the shortest wavelength is in the
last position used.

4. Close the cytometer side drawer or front door(s).

e Detector array configurations (page 129)
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Custom configurations and baselines

About this topic This topic describes where to find information on how to
create a custom configuration and define a baseline for a
performance check.

Overview BD™ Cytometer Setup and Tracking (CS&T) software is
used to define the baseline performance of your cytometer. A
baseline provides a starting point for the tracking of
cytometer performance. When running a performance check,
you compare the results to the baseline.

Some BP filters might not be normalized to CS&T settings.
In this case, CS&T will generate Qr and Br numbers that are
not comparable from instrument to instrument. They are
however, still trackable on one cytometer. In addition, you
must carefully check the PMT voltages that CS&T sets for
these filters. See Optimizing cytometer settings (page 57).
Please see the latest published filter guides available on our
website (bdbiosciences.com) for more information.

See the BD Cytometer Setup and Tracking Application
Guide for information on creating custom configurations
and defining a baseline.

Related topics e Running a performance check (page 64)



http://www.bdbiosciences.com

Need more information fast?

Information about this product is also available in your
software's Help system.

You can keep the Help window open while you use the
software or print the information directly from the window.

Internet access is not required to use the Help system.




Maintenance

This section covers the following topics:

e Maintenance overview (page 40)

e Cleaning the fluidics (page 41)

e Shutting down the cytometer (page 43)

e Flushing the system (page 44)

e Maintaining the waste management system (page 46)
e Replacing the waste air filter (page 49)

e Changing the sheath filter (page 50)

e Changing the Bal seal (page 52)

e Changing the sample tube O-ring (page 54)
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Maintenance overview

About this topic

General use quidelines

A A

A\

This topic provides an overview of the BD LSRFortessa
routine maintenance and cleaning procedures.

Caution: Biohazard! Coming into contact with all biological
specimens and materials is considered biohazardous.

Follow these guidelines whenever operating or maintaining
the cytometer:

e Handle all biological specimens and materials as if they
are capable of transmitting infection.

e Dispose of waste using proper precautions and in
accordance with local regulations.

e Never pipette by mouth.
e  Wear suitable protective clothing, eyewear, and gloves.

For fluidics maintenance, we recommend the following
cleaning solutions:

e BD™ FACSClean solution
o 10% bleach solution
e 0.5% solution of sodium hypochlorite

Use DI water to dilute bleach and sodium hypochlorite to
appropriate concentrations.

Caution! Higher concentrations of sodium hypochlorite
and use of other cleaning solutions might damage the
cytometer.



When to perform
maintenance procedures

Chapter 4: Maintenance

Perform maintenance procedures in the following

frequencies.

Frequency

Daily

Scheduled (every
two weeks)

Periodic (frequency
depends on how
often you run the
cytometer)

Maintenance procedure

Cleaning the fluidics (page 41)
Shutting down the cytometer

(page 43)

Flushing the system (page 44)
Maintaining the waste management
system (page 46)

Changing the sheath filter (page 50)
Changing the Bal seal (page 52)

Changing the sample tube O-ring
(page 54)

Cleaning the fluidics

About this topic

Overview

This topic describes how to perform the daily fluidics

cleaning.

Cleaning the fluidics daily prevents the sample injection tube
from becoming clogged and removes dyes that can remain in

the tubing.

In addition to daily cleaning, follow this procedure
immediately after running viscous samples or nucleic acid

dyes such as Hoechst, DAPI, propidium iodide (PI), acridine

orange (AO), or thiazole orange (TO).

41
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Procedure

To clean the fluidics:

1.
2.

N ok

Press RUN and HI on the cytometer fluid control panel.

Install a tube containing 3 mL of a cleaning solution on
the SIP with the support arm to the side (vacuum on) and
let it run for 1 minute.

For the cleaning solution, use BD FACSClean solution.
See Maintenance overview (page 40) for other
recommended cleaning solutions.

Move the tube support arm under the tube (vacuum off)
and allow the cleaning solution to run for 5 minutes with
the sample flow rate set to HI.

Repeat steps 2 and 3 with BD™ FACSRinse solution.
Repeat steps 2 and 3 with DI water.
Press the STNDBY button on the fluidics control panel.

Place a tube containing no more than 1 mL of DI water
on the SIP.

A tube with 1 mL of DI water should remain on the SIP
to prevent salt deposits from forming in the injection
tube. This tube also catches back drips from the flow
cell.

Caution! Do not leave more than 1 mL of water on the
SIP. When the instrument is turned off or left in standby
mode, a small amount of fluid will drip back into the
sample tube. If there is too much fluid in the tube, it
could overflow and affect the cytometer performance.
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Shutting down the cytometer

About this topic This topic describes how to shut down the cytometer.

Before you begin Each time you shut down the cytometer, perform the daily
cleaning as described in Cleaning the fluidics (page 41).

Procedure To shut down the cytometer:
1. Place a tube of DI water on the SIP.

2. Turn off the flow cytometer.

3. Select Start > Shutdown to turn off the computer (if
needed).

4. 1If your system is using the BD FACSFlow supply system,
shut off the BD FACSFlow supply system.

If the cytometer will not be used for a week or longer,
perform a system flush and leave the fluidics system filled
with DI water to prevent saline crystals from clogging the

fluidics.

Related topics e Cleaning the fluidics (page 41)

e Flushing the system (page 44)
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Flushing the system

About this topic

Cautions

A A

Procedure

This topic describes how to perform an overall fluidics
cleaning to remove debris and contaminants from the sheath
tubing, waste tubing, and flow cell. Perform the system flush
at least every 2 weeks.

Note: If you are using the BD FACSFlow supply system, see
the BD FACSFlow Supply System User’s Guide for
instructions on flushing the system.

Caution: Biohazard! The cytometer hardware might be
contaminated with biohazardous material. Use 10% bleach
to decontaminate the instrument.

To perform a system flush:

1. Remove the sheath filter.

a. Press the quick-disconnects on both sides of the filter
assembly.

b. Remove the filter assembly.

c. Connect the two fluid lines.

Caution! Do not run detergent, bleach, or ethanol
through the sheath filter. They can break down the
filter paper within the filter body, causing particles to
escape into the sheath fluid, possibly clogging the flow
cell.

2. Empty the sheath container and rinse it with DI water.

3. Fill the sheath container with at least 1 L of undiluted
BD FACSClean solution.

4. Empty the waste container, if needed.

5. Open the roller clamp by the fluidics interconnect, and
drain the fluid into a beaker for 5 seconds.



Next step

10.

11.
12.
13.

Chapter 4: Maintenance

Remove the DI water tube from the SIP.
Prime the instrument twice:
a. Press the PRIME button on the fluidics control panel.

b. When the STNDBY button lights (amber), press the
PRIME button again.

Install a tube with 3 mL of undiluted BD FACSClean
solution on the SIP and put the tube support arm
underneath the tube.

See Maintenance overview (page 40) for other
recommended cleaning solutions.

Press RUN and HI on the cytometer fluid control panel.
Run for 30 minutes.

Press the STNDBY fluid control button and depressurize
the sheath container by lifting the vent valve.

Repeat steps 2 through 10 with BD FACSRinse solution.

Repeat steps 2 through 10 with DI water.

Replace the sheath filter and refill the sheath container
with sheath fluid.

Test the waste management system battery as described in
Maintaining the waste management system (page 46).

45
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Maintaining the waste management system

About this topic This topic describes how to maintain the waste management
system. The waste management system has an alarm
powered by a 9-volt battery that you must test and change
regularly to ensure continued operation.

When to perform the Test the battery every two weeks after you flush the system.
battery test Change the battery as needed.

Testing the battery and  To test the battery and alarm:

alarm . .
1. Locate the Battery Test switch on the waste container

bracket.

. :‘ Battery test switch

BATTERY TEST

2. Toggle the switch.

If the battery and the alarm are working properly, you
should hear an alarm buzzing. If you do not hear any
sound, change the battery as described in the following
section.

3. Release the switch.
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Changing the battery You need the following supplies to change the battery:

o Small flat-head screwdriver
e A 9-volt battery

To change the battery:

1. [Insert the tip of a flat-head screwdriver into the slot and
gently slide the battery drawer out.

2. Remove the drawer.
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3. Remove the battery from the drawer.

y/

4. Place a new 9-volt battery into the drawer.

The markings in the battery drawer show the correct
battery orientation.

5. Slide the drawer into the bracket until you feel a click.

6. Test the new battery.
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Replacing the waste air filter

About this topic This topic describes the procedure for replacing the waste air
filter. An air filter is located on the cap assembly of the waste
container.

Procedure

f Caution: Biohazard! Treat a contaminated air filter as

biohazardous waste.

To replace the air filter:

1.

Remove the air filter.

Hold the silicone tubing with one hand and pull off the
filter with the other hand.

Insert a new air filter into the silicone tubing.

Verify that the cap assembly on the container is
tightened.
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Changing the sheath filter

About this topic This topic describes how to change the sheath filter. The
sheath filter is connected in-line with the sheath line. It filters
the sheath fluid as it comes from the sheath container.

When to change the We recommend changing the sheath filter assembly every

sheath filter 6 months. Increased debris appearing in an FSC vs SSC plot
can indicate that the sheath filter needs to be replaced. See
Supplies and consumables (page 175) for ordering
information.

Sheath filter components

Sheath line

Vent fitting

Quick-disconnect )
Vent line

Filter base



Removing the old filter

Attaching the new filter

Chapter 4: Maintenance

To remove the old filter:

1.
2.

Place the cytometer in standby mode.

Remove the sheath filter assembly by pressing the
quick-disconnect on both sides of the filter assembly.

Opver a sink or beaker:
— Remove the vent line from the filter and set it aside.
— Remove the filter base and set it aside.

Discard the used filter assembly in an appropriate
receptacle.

To attach the new filter:

1.

Connect the vent line to the new filter assembly.
Twist to attach.

Wrap Teflon® tape around the filter threads, then
connect the filter to the filter base.

Connect the sheath line to the filter assembly by
squeezing the quick-disconnect.

Attach the cytometer fluid line to the filter assembly via
the quick-disconnect.

Direct the vent line into a beaker and press the small
button at the end of the vent fitting against the side of
the beaker until a steady stream of fluid empties from the
filter.

Tilt the filter and verify that no trapped air remains in
the filter.

Repeat steps 5 and 6 as necessary to remove all trapped
air.
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Changing the Bal seal

About this topic

When to change the Bal
seal

Procedure

This topic describes how to replace the Bal seal.

The sample injection tube Bal seal is a ring that forms a seal
with the sample tube and ensures proper tube pressurization.

Over time, the Bal seal becomes worn or cracked and
requires replacement. Replacement is necessary if a proper
seal is not formed when a sample tube is installed on the SIP.
Indications that a proper seal has not formed include:

The tube will not stay on the SIP without the tube
support arm.

When the tube is installed and RUN is pressed on the
cytometer, the RUN button is orange (not green).

To replace the Bal seal:

1.

Remove the outer sleeve from the sample injection tube
by turning the retainer counter-clockwise. Slide the outer
sleeve down and off of the sample injection tube.

Bal seal

Retainer

Outer sleeve

Sample injection tube

Work carefully. The outer sleeve can fall off as you
loosen the retainer.
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Remove the Bal seal by gripping it between your thumb
and index finger and pulling down.

[

Install the new Bal seal spring-side up.

Ensure that the sample tube O-ring is still in place inside
the retainer.

Re-install the retainer and outer sleeve over the sample
injection tube. Push the outer sleeve all the way up into
the sample injection port and then screw the retainer into
place and tighten to finger tight. This will seat the Bal
seal.

Install a sample tube on the SIP to ensure that the outer
sleeve has been properly installed.

If the sleeve hits the bottom of the tube, loosen the
retainer slightly and push the sleeve up as far as it will
go. Tighten the retainer.
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Changing the sample tube O-ring

About this topic

When to replace the
O-ring

Caution

A A

Procedure

This topic describes how to replace the sample tube O-ring.

The sample tube O-ring, located within the retainer, forms a
seal that allows the droplet containment vacuum to function

properly.

Replace the O-ring when droplets form at the end of the
sample injection tube while the vacuum is operating.

Caution: Biohazard! Cytometer hardware might be
contaminated with biohazardous material. Wear suitable
protective clothing, eyewear, and gloves whenever cleaning
the cytometer or replacing parts.

To change the O-ring:

1. Remove the outer sleeve from the sample injection tube
by turning the retainer counter-clockwise.

2. Slide the outer sleeve from the retainer.

O-ring

Retainer
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Invert the outer droplet sleeve and allow the O-ring to
fall onto the benchtop.

If the O-ring does not fall out initially, hold the O-ring
with your free hand and slide the outer sleeve to remove
the O-ring.

Place the new O-ring into the retainer. Make sure the
O-ring is seated properly in the bottom of the retainer.

Replace the outer sleeve in the retainer.
Re-install the retainer and the outer sleeve.

Install a sample tube on the SIP to ensure that the outer
sleeve has been properly installed.

If the sleeve hits the bottom of the tube, loosen the
retainer slightly and push the sleeve up as far as it will
go. Tighten the retainer.




Need more information fast?

Information about this product is also available in your
software's Help system.

You can keep the Help window open while you use the
software or print the information directly from the window.

Internet access is not required to use the Help system.




Optimizing cytometer settings

This section includes the following topics:

e Cytometer settings workflow (page 58)

e Verifying the configuration and user preferences (page 61)
e Running a performance check (page 64)

e Setting up an experiment (page 69)

e Creating application settings (page 73)

e Recording compensation controls (page 76)

e Calculating compensation (page 80)
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Cytometer settings workflow

About this topic

When to optimize
settings

Manual compensation

First-time users

Before you begin

This topic describes how to optimize cytometer settings. The
optimization is performed using the Cytometer Setup and
Tracking, Application Settings, and Compensation Setup
features of BD FACSDiva software.

Before you record data for a sample, optimize the cytometer
settings for the sample type and fluorochromes used.

Compensation setup automatically calculates compensation
settings. If you choose to perform compensation manually,
not all of the following instructions apply. For detailed
instructions, see the BD FACSDiva Software Reference
Manual.

If you are performing the procedures in this workflow for the
first time, you should be familiar with BD FACSDiva
software concepts: workspace components, cytometer and
acquisition controls, and tools for data analysis.

To become familiar with BD FACSDiva software, perform
the tutorial exercises in Getting Started with BD FACSDiva
Software.

For additional details, see the BD FACSDiva Software
Reference Manual.

Start the BD LSRFortessa cytometer and perform the setup
and QC procedures. See Cytometer setup (page 23).
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Workflow for optimizing Cytometer optimization consists of the following steps.
settings

Step Description

1 Verifying the configuration and user preferences
(page 61)

2 Running a performance check (page 64)

3 Setting up an experiment (page 69)

4 Creating application settings (page 73)

S Recording compensation controls (page 76)

6 Calculating compensation (page 80)

Note: Application settings are optional and do not have to
be saved for the experiments. However, they are useful for
optimizing cytometer settings.
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About the examples

The examples in this chapter use a 4-color bead sample with
the following fluorochromes:

e FITC

e PE

e PerCP-Cy™S5.5
e APC

If you follow this workflow with a different bead sample (or
another sample type), your software views, data plots, and
statistics might differ from the example. Additionally, you
might need to modify some of the instructions in the
procedure.

The information shown in italics is for example only. You
can substitute your own names for folders and experiments.




Chapter 5: Optimizing cytometer settings | 61

Verifying the configuration and user preferences

About this topic This topic describes how to verify the cytometer
configuration and user preferences before you create an
experiment.

cytometer configuration must reflect your BD LSRFortessa
cytometer optics.

2 Caution! To obtain accurate data results, the current

Procedure To verify the configuration and preferences before you create
an experiment:

1. Select Cytometer > View Configurations and verify the
current configuration.

Cytometer, Configuration ‘;‘@@

Cytometer: BDLSR Fortessa Current Configuration:  Copy of 6-Blue 4-Red 6-Yiolet 2-UY
Cytometer Name: LSRFortessa
Serial Number: 1

Configurations |Parameters | Fiters and Mirrors |

- ‘ 6-Blue 4-Red 6-Violet 2-UV {BD default)

£HEZ7|Base Configurations |
| B[ 6-Blue 4-Red b-Violet 2-Uv (BD default)

Blue Laser Red Laser violet Laser UV Laser
553 Custom ConfigUrations \ (4?:‘;2“1) (640nm) (405nm) (355nm)

| i [ple [ e ot [ |

Window Extension (us): 10,00

set Configuration | [ Prine | [ Export
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Your cytometer might include only the base
configuration when your cytometer is installed. You can
create additional configurations later as needed.

In this example, the cytometer configuration must
include the following parameters: FITC, PE,
PerCP-CyS5.5, and APC.

2. If you need to select a configuration other than the
current configuration:

a. In the Configurations tab, select a configuration.
b. Click Set Configuration.
c. Click OK.

d. Verify that the configuration you just set matches
your BD LSRFortessa cytometer optics.

3. Click OK to close the Cytometer Configuration window.
4. Select File > Exit to close CS&T.

5. Select Edit > User Preferences.
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6. Click the General tab and select the Load data after
recording checkbox.

¥ User Preferences

Genef’allGates ‘orksheet | Plob | FCS | Templates | Statistics | Biexponential

[] Tube-specific warkshest

|:| Start acquisition on pointer change

[ Show file identifier {GUIDY in statistics view

[[] remove tube-specific cytometer settings on duplicate

[[] 5ave analysis after recarding through global warksheet

See the BD FACSDiva Software Reference Manual for more
information about cytometer configurations and user
preferences.

Related topics e Setting up an experiment (page 69)
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Running a performance check

About this topic

Overview

Considerations

Before you begin

This topic describes how to run a performance check as part
of quality control.

The CS&T application is designed to monitor performance
on a daily basis and to optimize laser delay.

Running a performance check on a regular basis provides a
standard for monitoring changes in performance due to
degradation of laser power, aging of PMTs, and other
potential cytometer service issues. Performance results are
also affected by fluidics performance. We strongly
recommend following the fluidics maintenance procedures as
described in Cleaning the fluidics (page 41).

Some BP filters might not be normalized to CS&T settings.
In this case, CS&T will generate Qr and Br numbers that are
not comparable from instrument to instrument. They are
however, still trackable on one cytometer. Part of the process
for optimizing cytometer settings includes verifying PMT
voltages set by CS&T for all parameters. Carefully examine
any channel with a non-CS&T normalized filter.

Define the performance baseline for any configuration before
running a performance check. See Custom configurations
and baselines (page 37).
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Procedure To run a performance check:

1. Select Cytometer > CST.

Cytometer Setup and Tracking

File  Cytometer Tools

5ot |Reports| Perfomance Trackng |

trol iy

Load a kube with beads and dick Run button to start setup,

System Summary: Requires Attention

Chararterize: |Check Performance v
Cylometer Configuration &-Blue 4-Red 6-Violet 2-U¥ (BD default)
Lot ID: 54102 © Abort

Cytometer Configuration; 6-Blue +-Red 6-Violet 2-L (BD...

Cotameter Baseline January 18, 2010 10:26 AM
6k Select Corfiguration
Cytometer Performance: Mo Cytometer Performance is avalable for current configuration and bead lok.
Setup Beads
Lot 54102 v
Product: C5T Setup Beads
Part 910723

Expiration Date:  03-30-2011

Parameter

© Connected

2. Verify that the bead lot information under Setup Beads
matches the Cytometer Setup and Tracking bead lot.

Setup Beads
lobID:  |54102 v|

Product; 5T Setup Beads
Fart #: 10723
Ewpiration Date:  09-30-2011
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3. Verify that the cytometer configuration is correct for
your experiment.

System Summary: 0K

I Cybameter Configuration: Cusstom 6-Blue 4-Red &-Violet 2-LW I
Lot |D; 4102

If the cytometer is not set to the correct configuration:

a. Click Select Configuration in the Setup Control
window.

b. Select the correct configuration from the list.
c. Click Set Configuration and then click OK.

4. Verify that the current configuration has a valid baseline

defined.

If not, see the BD Cytometer Setup and Tracking
Application Guide for more information on defining a
baseline.

5. Prepare the CS&T beads according to the technical data
sheet provided with the beads or available on the
BD Biosciences website (bdbiosciences.com).

6. Install the bead tube onto the SIP.

7. In the Setup Control window, select Check Performance
from the Characterize menu.

Setup Conkrol - Research Use O
Lead a tube with beads and click Run button bo skart setup.

Charackerize: IChE:Bc. Perfarmance ¥
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10.

11.

12.
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Click Run.

Ensure that the SAMPLE FINE AD]J knob is set to the
midpoint and press RUN and LO.

Plots appear under the Setup tab and the performance
check is run. The performance check takes
approximately 5 minutes to complete.

Once the performance check is complete, click View
Report.

Verify that the cytometer performance passed.

In the Setup tab, the cytometer performance results
should have a green checkbox displayed and the word
Passed next to it.

iﬁ] Cutoresles Baselns: January 18, 2010 1026 aM
EE] Cytoeneled Peiloimasncs: January 20, 3010 0303 P

E] Cylomele: Pesloemance Resdlz: Pagzed

If any parameters did not pass, see the BD Cytometer
Setup and Tracking Application Guide for
troubleshooting information.

Select File > Exit to close the CS&T window and return
to the BD FACSDiva interface.



68 | BD LSRFortessa Cell Analyzer User's Guide

Next step

13.

The CST Mismatch dialog appears.

¥ CST Mismatch

The settings from CST are different from those on the cybometer.
] "_-.
-

Do you want bo uss the CST values?
] Don't show this message again for current login sessian.
| Detaisz> || usecsTsettings || Keep Current Settings |

Remember my decision,

Click the Details button to verify which cytometer
settings will be updated.

Click Use CST Settings.

By selecting Use CST Settings, the laser delay, area
scaling, and other cytometer settings will be updated to
the latest settings from the performance check.

Continue the optimization of your cytometer for an
experiment or sample type as described in Setting up an
experiment (page 69).
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Setting up an experiment

About this topic

Creating an experiment

This topic describes how to create an experiment in a new
folder, specify the parameters of the experiment, and add
compensation tubes.

To create an experiment:

1. Click the buttons on the Workspace toolbar to display
the following windows as needed:

Browser
Cytometer
Inspector
Worksheet

Acquisition Dashboard

When you add elements or make selections in the
Browser, the Inspector displays details, properties, and
options that correspond to your selection.

2. Click the New Folder button on the Browser toolbar to
add a new folder.

3. Click the folder and rename it MyFolder.

4. Click MyFolder, then click the New Experiment button
on the Browser toolbar.

[F£ Browser, - MyExperiment

a.

rﬁ_.&u N -

Marne
2 Administratar
1 i MyFolder

Click the new experiment in the Browser and rename it
MyExperiment.
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5. Select MyExperiment in the Browser.

The Inspector displays details for the experiment.

Specifying parameters To specify the parameters for the new experiment:
1. Select Cytometer Settings for the experiment in the
Browser.

B[] MyExperiment 1/4/07 8:54:15...

Cytomneter Settings |

Parsineters | Throshold | Ratio | Compensation|

Volage
kol
266
FLTC a7
PE
FE-Texas Red
FE-CyS
ParCP-Cy5.5
PE-Cy7
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2. Make sure the parameters you need appear on the
Parameters tab in the Inspector.

If more than one parameter is available for a particular
PMT, you might have to select the one you need from a
menu. For example, you can set Detector F for the blue
laser as FITC or Alexa Fluor® 488.

a. Click the Parameter name to display the available
fluorochromes in the Parameters list.

Inspector - Cytometer Settings
Cytometer Settings |

Parameters : Threshald Ratio Compensatic

i Parameter e
¢ F5C |20
e 55C 300
-
= PE 00

b. Select the specific parameter from the drop-down
menu. Your selection appears as the selected
parameter.

Inspector - Cytometer Settings

Cybometer Settings
Parameters | Threshaold | Ratio | Comy

Parameter
r F5C
v 550
* |FITC v
e |Blexa Fluor 438

. E—

c. For this example, select FITC from the menu.
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3. Delete any unnecessary parameters.

a. Click the selection button (to the left of the parameter
name) to select the parameter.

Inspector - Cytometer Settings |§|
Cytometer Settings |
Parameters | Threshald || Ratio | Compensation|
Parameter Yolkage Log A H W
r FSC 250 || ] 0 |-
e 55C 300 [d] O [d]
= FITC S00 F F
* PE 500 ] L]
PeriCP-Cy5-5 500 ¥ ¥
< 500 ™ ™
Pacific Blue 500 ] ]
» AmCyan 500 ¥ F (-
# Indo-1 (¥iolet) 500 H H
¢ Indo-1 (Blue) 500 H B |3
add [ Delete . ]
L

b. Click Delete. The parameter is deleted.
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Creating application settings

About this topic

About application
settings

Before you begin

Procedure

This topic describes how to create application settings.

Application settings are associated with a cytometer
configuration and include the parameters for the application,
area scaling values, PMT voltages, and threshold values, but
not compensation. Each time a performance check is run for
a configuration, the application settings associated with that
configuration are updated to the latest run.

Using application settings provides a consistent and
reproducible way to reuse cytometer settings for commonly
used applications.

You can include area scaling adjustment in your application
settings. See Adjusting area scaling (page 168) for more
information.

Perform the cytometer setup procedure and run a
performance check for the configuration that will be used for
the application.

To create application settings:

1. In the open experiment, right-click Cytometer Settings in
the Browser, then select Application Settings >
Create Worksheet.

A second global worksheet is added with the plots
created according to the selections in the Parameters tab.



74

BD LSRFortessa Cell Analyzer User's Guide

Globial Sheet] [ Global Sheet?

i
2

5504

EE

All Evenls

All Evants All Evernits

50

Fi ]
FEC-A

|r1||1|r1|r1||'||r1|[|||1|

Ion 250
i 1.000)

I||:|5
]
L

uﬂ
sl oyimal o

PE-A
ig?

1 AP-\"F-A 4
T R P

1]
|

‘='——|-rmq—rmq—rrrmrnmq—r
0] 5 i 2 g

IJ":'1 Il:l2 iI:|:I 10 10 10 10 =) |n‘ in
FITC-A FerCP-Cy5.5-A

g

Use the gray boxes and crosshairs to guide your
optimization.

Load the unstained control tube onto the cytometer.

In the Cytometer window, optimize the PMT voltages
for the application.

— Optimize the FSC and SSC voltages to place the
population of interest on scale.

— Optimize the FSC threshold value to eliminate debris
without interfering with the population of interest.

— If needed, increase the fluorescence PMT voltages to
place the negative population within the gray boxes.
Align the center of the negative population with the
crosshair visible in the gray box.

Note: Do not decrease the fluorescence PMT voltages.
Doing so can make it difficult to resolve dim populations
from the negative population.

Unload the unstained control tube from the cytometer.

Load the multicolor sample onto the cytometer or load
single-color control tubes and verify each fluorochrome
signal separately.
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Verify that the positive populations are on scale.

If a positive population is off scale, lower the PMT
voltage for that parameter until the positive population
can be seen entirely on scale.

Unload the multicolor sample.

Place a tube containing DI water on the SIP and put the
cytometer on standby.

(Optional) Save the application settings by right-clicking
Cytometer settings in the Browser, then selecting
Application Settings > Save.

10. In the Save Application Settings dialog, enter a

descriptive name for the application settings.

Save Application Settings

Enter a name for the Application Settings

| LSRFortessa 4 Color Application Settings |

[ Ok ] [ Cancel ]

11. Click OK.

The application settings are saved to the catalog.
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Recording compensation controls

About this topic This topic describes how to create and record compensation
controls using the Compensation Setup feature of
BD FACSDiva software and an experiment with optimized
settings.

Creating compensation  To create compensation control tubes:
tubes

1. Select Experiment > Compensation Setup >
Create Compensation Controls.
The Create Compensation Controls dialog opens.

For this bead example, you do not need to provide non-
generic tube labels.

¥l Modify Compensation Controls

Include separate unstained control fubefwelt

Fluorophaore Label
* FITC (GENeric
* FE (GENeric
* PerCP-Cy5-5 (GEnEric
" APC (GEneric




Recording compensation

settings
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2. Click OK.

Compensation control tubes are added to the
experiment. Worksheets containing appropriate plots
and gates are added for each compensation tube.

ompensation Conk
2 Cytometer Sett
W Unstained Cort
W FITC Stained
W PE stained Con
U PercP-cys-5 3t
@[ APC Stained Co

To record compensation settings:

1.
2.

Press RUN and HI on the cytometer fluid control panel.
Install the unstained control tube onto the SIP.

Expand the Compensation Controls specimen in the
Browser.

Set the current tube pointer to the unstained control tube
(it becomes green), then click Acquire Data in the
Acquisition Dashboard.

Verify that the population of interest is displayed
appropriately on the FSC vs SSC plot and adjust voltages
if necessary.

nstained Control

1]
1

ol

S5C-A (= 1,000)
oo 150 %

s

||||||.||.|||i|.|.|-|||-.||||||||
a0 100 150 200 250
Fac-p = 1,0007
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Since the application settings have been optimized for
your sample, the cytometer settings should not require
adjustment other than the changing of FSC and SSC
voltages to place the beads on scale.

6. Adjust the P1 gate to surround only the singlets.

7. Right-click the P1 gate and select Apply to All
Compensation Controls.

The P1 gate on each stained control worksheet is
updated with your changes.

8. Click Record Data.

9. When recording is finished, remove the unstained
control tube from the cytometer.

10. Click Next Tube.

Caution! Do not change the PMT voltages after the

A first compensation control has been recorded. In order
to calculate compensation, all controls must be
recorded with the same PMT voltage settings. If you
need to adjust the PMT voltage for a subsequent
compensation control, you must record all
compensation controls again.

11. Install the next tube onto the cytometer and repeat steps
8 through 10 until data for all stained control tubes has
been recorded.

12. Double-click the first stained control tube to display the
corresponding worksheet.
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13. Verify that the snap-to interval gate encompasses the
positive population.

o FITC-Stained Control FITC- Stained Control
= B 2
@ =g
58 ke
@2 Sg]

£ En

TTTT | TTTT | TTTT | TTTT | TTTT | T ||||||I| T ||||||I| T ||||||I| T ||||||I| T
50 w0 sz 0 1w? 10? 1t 1wd
FSC-A (x 1.000) FITC

14. Repeat steps 12 and 13 for the remaining compensation
tubes.

Next step After you have recorded data for each single-stained control,
calculate compensation as described in Calculating
compensation (page 80).
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Calculating compensation

About this topic

Before you begin

Procedure

Related topics

This topic describes how to calculate compensation.

Before you can calculate compensation, you need to record
the data for each single-stained control.

To calculate compensation:

1.

Select Experiment > Compensation Setup > Calculate
Compensation.

Note: If the calculation is successful, a dialog is
displayed where you can enter a name for the
compensation setup.

Note: The default name is year/month/day/time.

Enter a setup name and click Link & Save.

The compensation is linked to the cytometer settings and
saved to the catalog.

To help track compensation setups, include the
experiment name, date, or both in the setup name.

The compensation setup is linked to the MyExperiment
cytometer settings, and subsequent acquisitions in
MyExperiment are performed with the new
compensation settings.

We recommend that you always visually and statistically
inspect automatically calculated spectral overlap values. The
means of the positive controls should be aligned with the
means of the negative controls.

Recording compensation controls (page 76)




Recording and analyzing data

This section includes the following topics:

e Data recording and analysis workflow (page 82)
e Preparing the workspace (page 83)

e Recording data (page 895)

e Analyzing data (page 88)

e Reusing an analysis (page 94)
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Data recording and analysis workflow

About this topic

About the examples

This topic outlines the basic acquisition and analysis tasks
using BD FACSDiva software.

The examples in this chapter is from two 4-color bead
samples with the following fluorochromes:

e FITC
e PE

e PerCP-CyS.S
e APC

If you use a different sample type or if you have skipped the
optimization steps in Optimizing cytometer settings

(page 57), your software window content, names of folders
and experiments, and your data plots and statistics might
differ from those shown here. You might also need to modify
some of the instructions in the procedure.

For additional details on completing some of the following
steps, see the BD FACSDiva Software Reference Manual.

This procedure builds on the results obtained in Optimizing
cytometer settings (page 57).
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Workflow for recording  Recording and analyzing data consists of the following steps.
and analyzing data

Step Description

1 Preparing the workspace (page 83)
2 Recording data (page 85)

3 Analyzing data (page 88)

4 Reusing an analysis (page 94)

Preparing the workspace

About this topic This topic describes how to prepare the workspace and apply
application settings to your experiment before recording
data.

Procedure To prepare the workspace:

1. Using the Browser toolbar, create a new specimen in
MyExperiment and rename it FourColorBeads.

2. Create two tubes for the FourColorBeads specimen.
Rename the tubes Beads_001 and Beads_002.

3. Expand the Global Worksheets folder in MyExperiment
to access the default global worksheet, and rename the
worksheet MyData.
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Applying saved
application settings to a
new experiment

Related topics

4. On the MyData worksheet, create the following plots for
previewing the data:

FSC vs SSC

FITC vs PE

FITC vs PerCP-CyS5.5
FITC vs APC

When applications settings are applied to an experiment, the
cytometer settings are updated with the parameters included
in the application settings, optimized PMT voltages,
threshold settings, area scaling factors, and window
extension values.

To apply saved application settings to your experiment:

1. Right-click the experiment-level Cytometer Settings and
select Application Settings > Apply.

2. In the Application Settings catalog, select the application
settings file you saved previously and click Apply.

If the parameters are not the same, a mismatch dialog
opens.

Click Overwrite to update all settings.

Click Apply to change only the common parameters.

For more information, see the BD FACSDiva Software
Reference Manual.

The cytometer settings are renamed application settings and
the cytometer settings icon in the Browser changes.

e Creating application settings (page 73)

e Recording data (page 85)
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Recording data

About this topic This topic provides an example of how to preview and
record data for multiple samples.

Before you begin Prepare the sample tubes.

Recording data To record data:
1. Press RUN and HI on the cytometer fluid control panel.

2. [Install the first sample tube onto the SIP.
3. Set the current tube pointer to Beads_001.

4. Click Acquire Data in the Acquisition Dashboard to
begin acquisition.

5. While data is being acquired:

— Draw a gate around the singlets on the FSC vs SSC
plot.

— Rename the P1 gate to Singlets.

— Use the Inspector to set the other plots to show only

the singlet population by selecting the Singlets
checkbox.

Population | Drar
[~ Il &Il Everts
~ M singlets 1

6. Click Record Data.
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7. When event recording has completed, remove the first

10.
11.

12.
13.

tube from the cytometer.

The MyData worksheet plots should look like the

following.

FourColorBeads-Beads_001

(x 1.000)
n 2

il

S5C-A
150

100

)

TTTT | TTTT | TTTT | TTTT | TTTT | T
S0 00 &0 200 280
(35860, 135046) FEC-A (x 1.000)

FourColorBeads-Beads_001

FITC-A

FourColorBeads-Beads_001

10°

FercP-Cys.5
1t

10°

FourColorBeads-Beads_001

Install the second sample tube onto the SIP.

Set the current tube pointer to Beads_002.

Click Acquire Data to begin acquisition.

Before recording, preview the data on the MyData
worksheet to verify that all expected populations are
visible and the data is similar to the previous sample.

Click Record Data.

When event recording has completed, remove the second

tube from the cytometer.




Related topics

14.

15.

16.
17.
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If you are recording more than two tubes, repeat steps 8
through 13 for the remaining tubes.

Print the experiment-level cytometer settings by right-
clicking the Cytometer Settings icon in the Browser and
selecting Print.

Install a tube of DI water onto the SIP.

Place the cytometer in standby mode.

Analyzing data (page 88)
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Analyzing data

About this topic

Analyzing data

This topic describes how to analyze recorded tubes by
creating plots, gates, a population hierarchy, and statistics
views on a new global worksheet.

To analyze data:

1.

Use the Browser toolbar to create a new global
worksheet. Rename it MyDataAnalysis.

Create the following plots on the MyDataAnalysis
worksheet:

— FSCvs SSC

— FITCvs PE

— FITC vs PerCP-CyS5.5
— FITCvs APC

Create a population hierarchy and a statistics view, and
set them below the plots on the worksheet.

— Right-click any plot and select Show Population
Hierarchy.

— Right-click any plot and select Create Statistics View.
Set the current tube pointer to Beads_001.
Draw a gate around the singlets on the FSC vs SSC plot.

Use the population hierarchy to rename the population
Singlets.
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7. Select all plots except the FSC vs SSC plot, and use the
Plot tab in the Inspector to specify to show only the
singlet population.

Inspector - Dot Plot

Tube:
X Parameter: FaiZ-8 b
¥ Parameter: S5C-A, w

Biexponential Display
[ Axis
] Ais

Flot Elements

[Jarid Flat Outline Tick Labels
Background Color: [w] Grid Cutline Tick Marks

[] @ Ful ) Half

Population Diraw

]Il 2l Everts
Bl singlets 1
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8. Select all plots, and click the Title tab in the Inspector.
Select the Tube and Populations checkboxes to display
their names in plot titles.

Inspector - Dot Plot &|

| Plct | Title | Labels || Acquisition | Dat Plot |

Title Content

C&p Tube [] Populations
[] Custarn Title:

Title Fank

[Jtalic  []Eold

9. On all fluorescence plots:

— Make all plots biexponential. Select all fluorescence
plots and select the X Axis and Y Axis checkboxes in
the Plot tab of the Inspector.

Inspector. - Dot Plot

Plot | Title | Labels | Acquisition | Dot Plot |

Tube: eads, Specimen_001,Beads_001
* Parameter: FSC-4 hd
f Parameter: S5C-A b

Cytometer Setup

% fiis
Y Axis

— In the FITC vs PE plot, draw a gate around the
FITC-positive population. Name the population
FITC positive in the population hierarchy.
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— In the FITC vs PE plot, draw a gate around the
PE-positive population. Name the population PE
positive in the population hierarchy.

— In the FITC vs PerCP-CyS5.5 plot, draw a gate around
the PerCP-CyS5.5-positive population. Name the
population PerCP-CyS5.5 positive in the population
hierarchy.

— In the FITC vs APC plot, draw a gate around the
APC-positive population. Name the population APC
positive in the population hierarchy.

10. Format the statistics view.

a. Right-click the statistics view and select Edit Statistics
View.

b. Click the Header tab and select the Specimen Name
and Tube Name checkboxes.

c. Click the Populations tab and select all populations
except All Events. Clear the %Parent, % Total, and
#Events checkboxes.

d. Click the Statistics tab and select the mean for each of
the fluorescence parameters.
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¥l Edit Statistics View

. @ [ P s A [Tar ar s a[a

All Min Max | GeoM...| Mean | Median 5D [=ie] FoCy Yol T Mode
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PE-A |3 O i O O L] L] O |
PerCP-CY5.5 B H O O O O | | a |
APCA L O L} L L L O O Ll
Time O] 0O O O O 0 0O O O O O
Decimal Places 1] 0 1] 1] i} il ] 1 1 i}

(%) Sort by Parameter () Sork by Formula

[ Display Range | Liear 5

e. Click OK.

11. Print the analysis.
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Your global worksheet analysis objects should look like
the following.

_ Beads _001-All Events Eeads_001-Singlets
- E |- PE positive
557 5 '
- . w N
m . -
@ g Singlets D_“"E_=
BE o] FITC post
_IIII|I..II..I|I.I.II|.IIII|IIII|I TTTITm IIIIIIII| IIIIIIII| T
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Beads_001-Singlets Beads_001-Singlets
g* PerCP-Cy 5.5 positive VC,_= ARC positive
i ' <3
< &1
a Loy
:I IIIIII| T IIIIII| L IIIIII| L IIIIII| T L IIIIII| TT IIIIII| T
w? 10? 1t 10d 1t 10d
FITC-4 FITC-A
Tube: Beads_001
Fopulation #Events %Parent %Total
W 4l Events 10,000 1000
Ll singlets 9,675 968 0GB
FITC positive 4,774 493 477
FE positive 1,499 1548 150
FPerCP-Cy5.5 positive 1,529 15.8 158.3
AP positive 1,829 1849 183
Specimen Mame: FourColorBeads
Tube Mame: Beads_001
FITC-A FPE-A FPerCP-Cy5.5-A  APC-A
Fopulation Mean Mean Mean Mean
M singlets 1,969 1,727 1,287 3,956
E FITC positive 3,880 40 43 k]
B FE positive 95 10,858 T 16
W FercP-Cys.5 positive 106 GE 7639 380
O aPc positive 91 a9 a4 20,482
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Related topics

e Reusing an analysis (page 94)

Reusing an analysis

About this topic

Reusing an analysis

Saving the analysis

This topic describes how to use a global worksheets to apply
the same analysis to a series of recorded tubes. Once you
define an analysis for a tube, you can use it to analyze the
remaining tubes in the experiment. After viewing the data,
print the analysis or save it to a normal worksheet.

To reuse the analysis:
1. Set the current tube pointer to the Beads_002 tube.

2. View the Beads_002 data on your analysis worksheet.
Adjust the gates as needed.

Adjustments apply to subsequent tubes viewed on the
worksheet. To avoid altering a global worksheet, save an
analysis to a normal worksheet, then make adjustments
on the normal worksheet.

3. Print the analysis.

When you perform analysis with a global worksheet, the
analysis does not save with the tube.

If you define your analysis on a global worksheet before
recording data, you can specify to automatically save the
analysis after recording data. You set this option in User
Preferences.

To save a copy of the analysis with a tube:

1. Expand the MyDataAnalysis global worksheet icon in
the Browser.



Applying an analysis to
normal worksheets

Related topics
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2. Right-click its analysis and select Copy.

-] FourCalarBeads
> ----- 53 Cytometer Settings
@ Global Waorkshests

E| My Data Analysis

™ analysis

3. Click the Worksheets View button on the Worksheet
toolbar to switch to the normal worksheet view.

4. Select Worksheet > New Worksheet to create a new
normal worksheet.

5. Right-click the Beads_001 tube icon in the Browser, and
select Paste.

IJ:')—'&t FourColorBeads |
& I5 Beads_001 W ocut Chrk+x
=] 1 Beads_oo2 iy
B Copy Chrl+C

S Shared Wisw

Delete Delete

The analysis objects from the MyDataAnalysis global
worksheet are copied to the Beads_001_Analysis normal

worksheet. Double-click the Beads_001 tube in the
Browser to view the analysis.

You can apply the global worksheet analysis to multiple
tubes (on a single normal worksheet) by selecting multiple
tubes before pasting the analysis. Ensure that you collapse all
tube elements in the Browser before you paste them to
multiple tubes.

e Analyzing data (page 88)




Need more information fast?

Information about this product is also available in your
software's Help system.

You can keep the Help window open while you use the
software or print the information directly from the window.

Internet access is not required to use the Help system.
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Technical overview

This section contains a technical overview of the following topics:
e About fluidics (page 98)
e About optics (page 100)

e About electronics (page 111)
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About fluidics

About this topic

Pressure-driven fluidics
system

Hydrodynamic focusing

Low sample
pressure
(12 y/min)

Sample

This topic describes the fluidics system in the
BD LSRFortessa flow cytometer.

The fluidics system in the BD LSRFortessa flow cytometer is
pressure driven. A built-in air pump provides a sheath
pressure of 5.5 psi. After passing through the sheath filter,
sheath fluid is introduced into the lower chamber of the
quartz flow cell.

The sample to be analyzed arrives in a separate pressurized
stream. When a sample tube is placed on the SIP, the sample
is forced up and injected into the lower chamber of the flow
cell by a slight overpressure relative to the sheath fluid. The
conical shape of the lower chamber creates a laminar sheath
flow that carries the sample core upward through the center
of the flow cell, where the particles to be measured are
intercepted by the laser beam. This process is known as
hydrodynamic focusing.

High sample
pressure
(60 pyl/min)

Laser beam Laser beam

Sheath
fluid

T Sheath

fluid

Sheath T

fluid Sample
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The objective in flow cytometric analysis is to have at most
one cell or particle moving through a laser beam at a given
time. The difference in pressure between the sample stream
and sheath fluid stream can be used to vary the diameter of
the sample core.

Increasing the sample pressure increases the sample flow rate
thereby increasing the core diameter. The flow rate should be
set according to the type of application you are running.

e A higher flow rate is generally used for qualitative
measurements such as immunophenotyping. The data is
less resolved, but is acquired more quickly.

e A lower flow rate is generally used in applications where
greater resolution and quantitative measurements are
critical, such as DNA analysis.

Proper operation of fluidic components is critical for
particles to intercept the laser beam properly. Always ensure
that the fluidics system is free of air bubbles and debris, and
is properly pressurized.
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About optics

About this topic

Optics system

Light scatter

This topic describes the optics system and provides
information about:

e Light scatter on this page
e Fluorescence (page 101)
e Optical filter theory (page 103)

e Compensation theory (page 108)

The optics system consists of lasers, optical filters, and
detectors. Lasers illuminate the cells or particles in the
sample and optical filters direct the resulting light scatter and
fluorescence signals to the appropriate detectors.

When a cell or particle passes through a focused laser beam,
laser light is scattered in all directions. Light that scatters
axial to the laser beam is called forward scatter (FSC) and
light that scatters perpendicular to the laser beam is called
side scatter (SSC).

Side scatter (SSC)

Light source Forward scatter (FSC)




Fluorescence
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FSC and SSC are related to certain physical properties of
cells.

e FSC. Indicates relative differences in the size of the cells
or particles. Larger cells scatter more light and therefore
they are higher in FSC.

e SSC. Indicates relative differences in the internal
complexity or granularity of the cells or particles. More
granular cells deflect more light than less granular cells,
and therefore are higher in SSC.

When cells or particles stained with fluorochrome-
conjugated antibodies or other dyes pass through a laser
beam, the dyes can absorb photons (energy) and be
promoted to an excited electronic state. In returning to their
ground state, the dyes release energy, most of which is
emitted as light. This light emission is known as fluorescence.

Fluorescence is always a longer wavelength (lower-energy
photon) than the excitation wavelength. The difference
between the excitation wavelength and the emission
wavelength is known as the Stokes shift. Some fluorescent
compounds such as PerCP exhibit a large Stokes shift,
absorbing blue light (488 nm) and emitting red light

(675 nm), while other fluorochromes such as FITC have a
smaller Stokes shift, absorbing blue light (488 nm) and
emitting green light (530 nm).
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MNormalized Emission (%)

The following figure shows the emission spectra of some
commonly used fluorochromes.
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Actual emission intensity will depend on excitation
wavelength. See Fluorescence spectra (page 130) for more
information on excitation and emission of fluorochromes.
An interactive spectral viewer is also available at
bdbiosciences.com/colors/fluorescence_spectrum_viewer.


http://www.bdbiosciences.com/colors/fluorescence_spectrum_viewer/

Optical filter theory

Types of optical filters
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Optical filters modify the spectral distribution of light scatter
and fluorescence directed to the detectors. When photons
encounter an optical filter, they are either transmitted,
absorbed, or reflected.

Photons
Photons absorbed Photons
transmitted reflected
\

Even though an optical filter is rated at its 50% transmission
point, the filter passes (lets through) a minimal amount of
light outside of this indicated rating.

The slope of an optical filter transmission curve indicates
filter performance. A relatively steep slope indicates a high-
performance, high-quality optical filter that provides deep
attenuation of out-of-band wavelengths. A less steep slope
indicates that more light outside the rated bandwidth is being
transmitted.

There are four types of filters.

e Longpass (LP) filters. Transmit wavelengths that are
longer than the specified value.

e Shortpass (SP) filters. Transmit wavelengths that are
shorter than the specified value. This type of filter is not
recommended, but can be used in some custom
configurations. See Shortpass (SP) filters on page 105.

e Bandpass (BP) filters. Pass a narrow spectral band of
light by combining the characteristics of shortpass filters,
longpass filters, and absorbing layers.
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Longpass (LP) filters

e Notch filters. Pass all frequencies except those in a stop
band centered on a center frequency. They are the
opposite of bandpass filters.

The LSRFortessa uses LP filters and BP filters. Notch filters
are sometimes used in special order BD LSRFortessa
instruments.

LP filters pass wavelengths longer than the filter rating. For
example, a 500-LP filter permits wavelengths 500 nm or
longer to pass through it and either absorbs or reflects
wavelengths shorter than 500 nm.

Longpass

480 520
100 460 500 540

50 4— — — — — —

LP 500

% Transmission

T T
450 500 550
Wavelength (nm)




Shortpass (SP) filters
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An SP filter has the opposite properties of an LP filter. An SP
filter passes light with a shorter wavelength than the filter
rating. For example, a 500-SP filter passes wavelengths of
500 nm or shorter, and reflects or absorbs wavelengths
longer than 500 nm.

Shortpass
100 — 480 520
460 500 540
c
o
A
= 1
%) ~ ~
S \
= |
R
o | ~SP 500
T T I 1
450 500 550
Wavelength (nm)
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Bandpass (BP) filters

% Transmission

100

50

A BP filter transmits a relatively narrow range or band of
light. BP filters are typically designated by two numbers. The
first number indicates the center wavelength and the second
refers to the width of the band of light that is passed. For
example, a 500/50-BP filter transmits light that is centered at
500 nm and has a total bandwidth of 50 nm. Therefore, this
filter transmits light between 475 and 525 nm.

Bandpass

460 500 540
480 520

I I
450 500 550

Wavelength (nm) "V

The performance of an optical BP filter depends on the
optical transmission. Sample transmission curves are shown
in the following figure. A filter with a narrower (steeper)
transmission curve generally yields higher performance. The
transmission specifications depend on the construction of the
filter.

Higher performance filters generally have multiple layers of
optical coatings and unique manufacturing processes. For
more demanding multicolor applications, higher
performance filters are available through the Special Order
Research Program. Contact your local BD Biosciences sales
representative for details.
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Dichroic mirrors Dichroic filters that are used to direct different color light

signals to different detectors are called dichroic mirrors.

Although some of the properties of LP and SP filters are
similar to dichroic mirrors (for example, allowing a specific
wavelength range to pass), filters and mirrors cannot be used
interchangeably, especially if used as dichroic mirrors. A
dichroic mirror must have a surface coating that reflects
certain wavelengths, but many LP or SP filters are
absorbance filters that do not have any specific reflective
characteristics. Also, optical filters and dichroic mirrors are
rated at a specific angle of incidence. When used in front of
the fluorescence detectors, they are perpendicular to the
incident light, and when used as a dichroic mirror, they are
placed at an angle relative to the light source. Their optical
properties are therefore designed for that angle of incidence.
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Compensation theory

Fluorochromes emit light over a range of wavelengths.
Optical filters are used to limit the range of frequencies
measured by a given detector. However, when two or more
fluorochromes are used, the overlap in wavelength ranges
often makes it impossible for optical filters to isolate light
from a given fluorochrome. As a result, light emitted from
one fluorochrome appears in a detector intended for another.
This is referred to as spillover. Spillover can be corrected
mathematically by using a method called compensation.

In the following example, FITC emission appears primarily
in the FITC detector, but some of its fluorescence spills over
into the PE detector. The spillover must be corrected or
compensated for. Alternatively, the spillover can be
minimized by discrete excitation of fluorchromes. In the
following example, excitation with a 561-nm laser (special
order) will help minimize spillover.

FITC PE
BP53030 BP575/26

Normalized intensity

T T 1
500 nm 550 nm 600 nm 650 nm 700 nm
Wavelength (nm)

This spillover can be seen in a dot plot of FITC vs PE. The
FITC spillover in the PE detector must be corrected as
demonstrated in the two figures that follow.
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FITC-positive
population

PE

Unstained
particles

FITC

Using the Compensation tab of the Cytometer window in
BD FACSDiva software, you can adjust the PE-%FITC
spectral overlap value. Compensation is optimal when the
positive and negative FITC populations have the same means
in the PE parameter statistics.

The following image shows the FITC spillover optimally
compensated out of the PE parameter.

PE-&
FITS-positive Population Mean
PE - (< unlabeled 20
population v
Unstained B FITC positive T W

particles — ]

BN (RN e Matching means

FITC

Once fluorescence compensation has been set for any sample,
the compensation setting remains valid for a subsequent dim
or bright sample (provided the signal is not saturated),
because compensation subtracts a percentage of the
fluorescence intensity. The following figure illustrates this
principle. Although the signals differ in intensity, the
percentage of the FITC spillover into the PE detector remains
constant.
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About electronics

About this topic

Pulse

This topic describes the electronics in the BD LSRFortessa
flow cytometer.

As cells or other particles pass through a focused laser beam,
they scatter the laser light and can emit fluorescence. Because
the laser beam is focused on a small spot and particles move
rapidly through the flow cell, the scatter or fluorescence
emission signal has a very brief duration—only a few
microseconds. This brief flash of light is converted into an
electrical signal by the detectors. The electrical signal is
called a pulse. The following figure illustrates the anatomy of
a pulse.

1. A pulse begins when a particle enters the laser beam. At
this point, both the beam intensity and signal intensity
are low.

Signal intensity

Time

2. The pulse reaches a maximum intensity or height when
the particle reaches the middle of the beam, where the
beam and signal intensity are the brightest. The peak
intensity, or height of the pulse, is measured at this point.

Signal intensity

Time

111
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3. As the particle leaves the beam, the pulse trails off below

the threshold.
z
S Z
[}
e
=
C
o
wv
Time
Pulse measurements The pulse processors measure pulses by three characteristics:
height, area, and width.
Pulse Height
Lt
o
s
2 Baseline
Threshold 1 HI 1 Z
0 volts i P
1 1 1 1
P Voo
1 | ! Window Gate ! -
ExWindnw Extension j«—, — ExWindnw Extension

Window Gate + Full Window Extension

e Height. The maximum digitized intensity measured for
the pulse.

e Area. The integration of all the digitized samples over
time, where time is the window gate plus 1/2 the window
extension added before the initial threshold, plus the
other half of the window extension value added after the
pulse drops below threshold.

e  Width. Calculates: -2y 64,000
Height



Digital electronics

Threshold
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BD LSRFortessa electronics digitize the signal intensity
produced by a detector. The digitized data is stored in
memory and further processed by the electronics to calculate:

e Pulse height, area, and width
e Compensation
e Parameter ratios

These results are transferred to your workstation computer
for further processing by BD FACSDiva software. For more
information about digital theory, see Digital Theory in the
BD FACSDiva Software Reference Manual.

The threshold is the level at which the system starts to
measure signal pulses. A threshold is defined for a specific
detector signal. The system continuously samples the
digitized signal data and calculates pulse area, height, and
width for all channels based on the time interval during
which the threshold is exceeded.

Thresholds can also be set for more than one parameter, and
pulse measures are based on either of the following:

e Intervals during which ALL signals exceed their
threshold value

e Intervals during which ANY signal exceeds its threshold
value
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Laser controls

Related topics

Controls in the Laser tab of the Cytometer window are used
to manually set the (laser) delay, area scaling, and window
extension values.

These parameters are set by BD Biosciences service personnel
during instrument installation and performance check and
are updated each time you run a performance check.

If needed, see Optimizing laser delay (page 165) for
instructions on manually adjusting laser delay settings. Do
not otherwise change the settings in the Laser tab unless
instructed to do so by BD Biosciences. Changing the settings
affects your data.

Cylometer - LSRFortessa (1)

Cytometer Connected

e Running a performance check (page 64)

e  Optimizing laser delay (page 165)




8

Troubleshooting

This chapter covers the following topics:

e Cytometer troubleshooting (page 116)

e Electronics troubleshooting (page 127)
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Cytometer troubleshooting

About this topic

Droplets are visible on
the SIP

This topic describes possible problems and recommended
solutions for BD LSRFortessa cytometer issues.

Possible causes

Worn O-ring in retainer

Outer sleeve is not seated in
the retainer

Outer sleeve is not on the
sample injection tube

Wiaste line is pinched,
preventing proper aspiration

Waste tank is full

Droplet containment vacuum
not functioning

The HTS acquisition control
switch is in plate mode

Recommended solutions

Replace the O-ring. See
Changing the sample tube
O-ring (page 54).

1. Loosen the retainer.

2. Push the outer sleeve up into
the retainer until seated.

3. Tighten the retainer.

Replace the outer sleeve.
1. Loosen the retainer.

2. Slide the outer sleeve over
the sample injection tube
until it is seated.

3. Tighten the retainer.

Check the waste line.

Empty the waste tank.

Call your BD service
representative.

Change the acquisition control
switch to tube mode. See the
BD High Throughput Sampler
User’s Guide for more
information.
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Sample tube not fitting

on SIP Possible causes Recommended solutions

Sample tube other than Use BD Falcon 12 x 75-mm

BD Falcon® tubes used sample tubes. See Equipment on
page 179.

Worn Bal seal Replace the Bal seal. See
Changing the Bal seal on
page S2.

Sample tube is cracked Transfer contents to a new tube.

Rapid sample aspiration
Possible causes Recommended solutions

Support arm is to the side Place the support arm under the
sample tube.

Droplet containment module = Try the solutions in Droplets are

is failing visible on the SIP (page 116). If
the issue is not resolved, call
your BD service representative.

No events in acquisition

display and RUN buttonis  pogsible causes Recommended solutions
green
Threshold is not set to the Set the threshold to the correct
correct parameter (usually parameter for your application.
FSC)

Threshold level is too high Lower the threshold level.

PMT voltage for threshold Set the PMT voltage higher for
parameter is set too low the threshold parameter.

Gating issue See the BD FACSDiva Software
Reference Manual for
information on setting gates.

Air in the sheath filter Purge the filter. See Removing
air bubbles on page 28.
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Possible causes

Air bubble or debris in flow
cell

No sample in the tube

Sample is not mixed properly

Wiaste tank is full

PMT voltages set too low or
too high for display
parameter

Too few events are displayed

Sample injection tube is
clogged

Bal seal is worn

Instrument is not warmed up

Recommended solutions

Prime the fluidics system. See
Priming the fluidics on page 33.

Verify that sample remains in
the tube and if necessary, add
sample to the tube or install a
new sample tube.

Mix the sample to suspend the
cells.

Empty the waste tank.

Adjust the PMT voltages.

Increase the number of events to
display.

Remove the sample tube to
allow backflushing.

If the event rate is still erratic,
clean the sample injection tube.
See Cleaning the fluidics on
page 41.

Replace the Bal seal. See
Changing the Bal seal on
page S2.

Wait 30 minutes for the
instrument to warm up.
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Possible causes Recommended solutions

Laser delay is set incorrectly | Adjust the laser delay settings.
See Manual settings on
page 163.

Laser is not functioning Verify the malfunction by
changing the threshold to an
alternative laser while running
the appropriate sample. If
unsuccessful, contact
BD Biosciences.

Tube is cracked or misshapen | Replace the sample tube.

No events in acquisition

display and RUN buttonis  possible causes Recommended solutions
orange
RUN is not activated Press the RUN button.
Sample tube is not installed Install the sample tube correctly
or is not properly seated on the SIP.
Waste container is Replace the waste air filter.
pressurized

Caution! Pressurized

contents might spray. Use
appropriate cautionary
measures.

1. Slowly loosen the waste
tank cap to relieve the
pressure in the waste tank.

2. Remove the waste vent filter
by rotating counter-
clockwise.

3. Install a new waste vent

filter.
Sample tube is cracked Replace the sample tube.
Waste tubing line is not Connect the waste tubing line to

connected to the waste cap the waste cap.
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No fluorescence signal

Possible causes

Sheath container is not
pressurized

Bal seal is worn

Air leak at sheath container

Sheath container is empty

Air in sheath filter

Recommended solutions

e Ensure that the sheath
container lid and all
connectors are securely
seated.

e Inspect the sheath container
O-ring inside the lid and
replace it if necessary.

Replace the Bal seal. See
Changing the Bal seal on
page 52.

Ensure that the sheath container
lid and all connectors are
securely seated.

Fill the sheath container.

Purge the filter. See Removing
air bubbles on page 28.

Possible causes

Incorrect fluorochrome
assignment

Wrong filter is installed

Laser is not functioning

Recommended solutions

Make sure that the cytometer
configuration in the software
matches the optical filters in the
cytometer and the configuration
is as expected.

Make sure the appropriate filter
is installed for each
fluorochrome. See Changing
optical filters and mirrors on
page 36.

Call your BD service
representative.
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No signal in red laser
channels Possible causes Recommended solutions

Incorrect laser delays due to e Check the fluid level in the
a change in the sheath tank sheath tank and refill if
fluid level necessary.

e Adjust the laser delay
settings. See Manual settings
on page 163.

High event rate

Possible causes Recommended solutions
Air bubbles in the sheath Remove the air bubbles. See
filter or flow cell Removing air bubbles on
page 28.
Threshold level is too low Increase the threshold level. See

the BD FACSDiva Software
Reference Manual for

instructions.
PMT voltage for the Set the PMT voltage lower for
threshold parameter is set the threshold parameter. See the
too high BD FACSDiva Software
Reference Manual for
instructions.
Sample is too concentrated Dilute the sample.

Sample flow rate is set to HI | Set the sample flow rate to
MED or LO.
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Low event rate

Possible causes

Threshold level is too high

Air bubble or debris in the

flow cell

PMT voltage for the
threshold parameter is set
too low

Sample is not adequately
mixed

Sample is too diluted

Sample injection tube is
clogged

Recommended solutions

Lower the threshold level. See
the BD FACSDiva Software
Reference Manual for
instructions.

Prime the fluidics system. See
Priming the fluidics on page 33.

Set the PMT voltage higher for
the threshold parameter. See the
BD FACSDiva Software
Reference Manual for
instructions.

Mix the sample to suspend the
cells.

Concentrate the sample. If the
flow rate setting is not critical to
the application, set the flow rate
switch to MED or HI.

Remove the sample tube to
allow backflushing.

If the event rate is still erratic,
clean the sample injection tube.
See Cleaning the fluidics on
page 41.



Erratic event rate

Distorted scatter
parameters
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Possible causes

Sample tube is cracked

Air bubble or debris in the

flow cell

Bal seal is worn

Sample injection tube is
clogged

Contaminated sample

Sheath filter is dirty

Recommended solutions

Replace the sample tube.

Prime the fluidics system. See
Priming the fluidics on page 33.

Replace the Bal seal. See
Changing the Bal seal on
page S2.

Remove the sample tube to
allow backflushing.

If the event rate is still erratic,
clean the sample injection tube.
See Cleaning the fluidics on
page 41.

Prepare the specimen again.
Ensure that the tube is clean.

Replace the filter. See Changing
the sheath filter on page 50.

Possible causes

Cytometer settings are
improperly adjusted

Air bubble in sheath filter or
flow cell

Recommended solutions

Optimize the scatter
parameters. See the

BD FACSDiva Software
Reference Manual for
instructions.

Purge the air from the filter. See
Removing air bubbles on
page 28.
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Excessive amount of
debris in display

Possible causes

Flow cell is dirty

Air leak at sheath container

Hypertonic buffers or
fixative

Recommended solutions

Flush the system. See Flushing
the system on page 44.

Ensure that the sheath container
lid is tight and all connectors
are secure.

Replace the buffers or fixative.

Possible causes

Threshold level is too low

Sheath filter is dirty
Flow cell is dirty
Dead cells or debris in
sample

Sample is contaminated

Stock sheath fluid is

contaminated

Recommended solutions

Increase the threshold level.

Replace the filter. See Changing
the sheath filter on page 50.

Flush the system. See Flushing
the system on page 44.

Examine the sample under a
microscope.

Re-stain the sample. Ensure that
the tube is clean.

Rinse the sheath container with
DI water, then fill the container
with sheath fluid from another
(or new lot) bulk container.



High CV or Poor QC
results

Chapter 8: Troubleshooting | 125

Possible causes

Air bubble in sheath filter or
flow cell

Sample flow rate is set too
high

Air leak at sheath container

Flow cell is dirty

The dichroic mirrors are
installed backwards

Waste tank is pressurized

Poor sample preparation

Recommended solutions

e Durge the filter. See
Removing air bubbles on
page 28.

e Prime the fluidics system.
See Priming the fluidics on
page 33.

Set the sample flow rate lower.

Ensure that the sheath container
lid is tight and all connectors are
secure.

Flush the system. See Flushing
the system on page 44.

Remove the dichroic mirrors,
reverse them, and replace them
in the optical slot.

Replace the waste vent filter.

Caution! Pressurized

contents might spray. Use
appropriate cautionary
measures.

1. Slowly loosen the waste
tank cap to relieve the
pressure in the waste tank.

2. Remove the waste vent filter
by rotating counter-
clockwise.

3. Install a new waste vent
filter.

Repeat sample preparation.
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Possible causes

Sample not diluted in same

fluid as sheath fluid

Optical filters are incorrect

Old or contaminated QC
particles

Instrument is not warmed up

Laser not functioning
Optical alignment problem

Optical filters are incorrect

Recommended solutions

Dilute the sample in the same
fluid as you are using for sheath.

Check the configuration and
insert the correct filters.

Make new QC samples and
perform the quality control
procedure again.

Wait 30 minutes for the
instrument to warm up.

Contact BD Biosciences.
Contact BD Biosciences.

Check the configuration and
insert the correct filters.
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Electronics troubleshooting

About this topic This topic describes possible problems and recommended
solutions for BD LSRFortessa electronic issues.

"Cytometer
Disconnected” in Possible causes Recommended solutions
cytometer window
Cytometer power is off Turn on the cytometer main
power.
Communication failure e In BD FACSDiva software,
between workstation and select Cytometer > Connect.
cytometer

e If connecting does not work,
restart the cytometer. Turn
the cytometer off, wait 1
minute, and turn on the
cytometer main power.

e If connecting still does not
work, contact
BD Biosciences.




Need more information fast?

Information about this product is also available in your
software's Help system.

You can keep the Help window open while you use the
software or print the information directly from the window.

Internet access is not required to use the Help system.




Detector array configurations

This chapter covers the following topics:

e Fluorescence spectra (page 130)

e About configuration maps (page 132)

e About the base configuration (page 133)

e Base configuration octagon and trigon maps (page 138)

e Special Order configurations (page 149)
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Fluorescence spectra

About this topic

Designing multicolor
panels

This topic shows sample emission spectra from common
fluorochromes, as well as the more common laser excitation
lines. This information is useful for designing multicolor
panels. An interactive fluorescence viewer is also available at
bdbiosciences.com/colors/fluorescence_spectrum_viewer.

The BD LSRFortessa cytometer is designed specifically for
multicolor research. There are many options for dyes,
reagents, and system configurations.

When choosing a configuration or panel, it is important to
remember that final results depend on the excitation and
emission spectra of the individual dye, the number of
fluorescently labeled binding sites on the cell, as well as
spectral overlap and spillover to other PMTs. For more
information about designing multicolor panels, see Selecting
Reagents for Multicolor Flow Cytometry

(Part No. 23-9538-02).


http://www.bdbiosciences.com/colors/fluorescence_spectrum_viewer/

Example laser and dye
interactions
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The following figure shows the emission spectra of some
common dyes, based on laser excitation. In many cases, a
given dye can be excited by multiple laser wavelengths,
yielding different emission intensities.
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About configuration maps

About this topic

Filter and mirror
arrangement

This topic describes the filter and mirror arrangements in the
detector arrays.

The filters are arranged in the detector array to steer
progressively shorter wavelengths of light to the next PMT in
the array. The longest wavelength should be in the A position
and the shortest wavelength should be in the last position
used.

There should not be any empty slots for any laser being used.
Always use a blank optic holder.

If a slot is filled with a filter or mirror, an identifying number
appears in that position on the configuration map. If a slot is
filled with a blank optic holder, that position on the
configuration map is unlabeled.
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About the base configuration

About this topic This section describes the base configuration options
available with the BD LSRFortessa.

Nine available The base configuration for a BD LSRFortessa cytometer
configurations supports detectors, filters, and mirrors for up to four lasers
to provide up to 18-color detection.

Number
of lasers  Colors = Lasers See section...
1 4 4 Blue Four-color blue laser configuration (page 139)
2 6 4 Blue Four-color blue laser configuration (page 139)
2 Red Two-color red trigon configuration (page 142)
7 5 Blue Five-color blue laser configuration (page 140)
2 UV Two-color UV laser configuration (page 148)
8 5 Blue Five-color blue laser configuration (page 140)

3 Red Three-color red laser configuration (page 143)
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Number
of lasers

3

Colors

8

10

11

14

Lasers

4 Blue
2 Red
20V

4 Blue
2 Red

2 Violet
5 Blue
3 Red
20V

5 Blue
3 Red

3 Violet
5 Blue
3 Red
6 Violet

See section...

Four-color blue laser configuration (page 139)
Two-color red trigon configuration (page 142)
Two-color UV laser configuration (page 148)
Four-color blue laser configuration (page 139)
Two-color red trigon configuration (page 142)
Two-color violet laser configuration (page 145)
Five-color blue laser configuration (page 140)
Three-color red laser configuration (page 143)
Two-color UV laser configuration (page 148)
Five-color blue laser configuration (page 140)
Three-color red laser configuration (page 143)
Three-color violet laser configuration (page 146)
Five-color blue laser configuration (page 140)
Three-color red laser configuration (page 143)

Six-color violet octagon (page 147)
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Number
of lasers  Colors = Lasers See section...
3 8 4 Blue Four-color blue laser configuration (page 139)
2 Red Two-color red trigon configuration (page 142)
20V Two-color UV laser configuration (page 148)
8 4 Blue Four-color blue laser configuration (page 139)
2 Red Two-color red trigon configuration (page 142)
2 Violet Two-color violet laser configuration (page 145)
10 5 Blue Five-color blue laser configuration (page 140)
3 Red Three-color red laser configuration (page 143)
20V Two-color UV laser configuration (page 148)
11 5 Blue Five-color blue laser configuration (page 140)
3 Red Three-color red laser configuration (page 143)
3 Violet Three-color violet laser configuration (page 146)
14 5 Blue Five-color blue laser configuration (page 140)
3 Red Three-color red laser configuration (page 143)

6 Violet Six-color violet octagon (page 147)
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Number
of lasers

4

Colors

10

13

16

18

Lasers

4 Blue
2 Red
2 Violet
20V

5 Blue
3 Red

3 Violet
20V

5 Blue
3 Red

6 Violet
20V

6 Blue
4 Red

6 Violet
20V

See section...

Four-color blue laser configuration (page 139)
Two-color red trigon configuration (page 142)
Two-color violet laser configuration (page 145)
Two-color UV laser configuration (page 148)
Five-color blue laser configuration (page 140)
Three-color red laser configuration (page 143)
Three-color violet laser configuration (page 146)
Two-color UV laser configuration (page 148)
Five-color blue laser configuration (page 140)
Three-color red laser configuration (page 143)
Six-color violet octagon (page 147)

Two-color UV laser configuration (page 148)
Six-color blue laser configuration (page 141)
Four-color red laser configuration (page 144)
Six-color violet octagon (page 147)

Two-color UV laser configuration (page 148)



Base configuration
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The BD LSRFortessa has one base configuration at
installation. Custom configurations can be added for
different applications. The following image shows a default
base cytometer configuration.

Cytometer Configuration

Cytometer:
Cytometer Name: LSRFortessa
Serial Number: 1

BDLSR Fortessa

Current Configuration:  Copy of 6-Blue 4-Red 6-Violet 2-UY

Canfigurations |Parameters | Filters and Mirrors |

/=7 Base Configurations

6-Blue 4-Red 6-¥iolet z-U¥ (BD default) B'::BL'?SE" RZ‘L;GSEF Viﬂ;sg Laser Usvséaser
53 custom Corfigurations ¢ ancm) (640nm) (405nm) (355nm)

6-Blue 4-Red 6-VYiolet 2-U¥ (BD default)

| [t | e | itet v |

Window Extension (us): 10,00

Set Configuration ] [ print

J [ Export
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Upgrade options

Related topics

The BD LSRFortessa cytometer optical configuration can be
upgraded to use different special order wavelength options
and a variety of detectors. See Special Order configurations
(page 149) for a list of some common special order laser/
detector combinations available through the BD Special
Order Research Program. Many other special order
configurations and options are also available.

e  Verifying the configuration and user preferences
(page 61)

e Base configuration octagon and trigon maps (page 138)

Base configuration octagon and trigon maps

About this topic

About the maps

This section describes how filters and mirrors are arranged
for standard trigon and octagon configurations.

The tables in this section show the detectors, filters, and
mirrors used in the each configuration, and recommended
fluorochromes for each detector. The word “blank” indicates
that a blank optical holder should be used instead of a mirror
or filter. A dash (—) indicates that no slot exists for a mirror
in that PMT position.
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Four-color blue laser The following map shows the four-color configuration for
configuration the 488-nm blue laser.
PMT LP mirror BP filter Fluorochromes
A 750 780/60 PE-Cy™7
B 685 695/40 PerCP-CyS5.5, PE-Cy™S§,
PerCP, PI
550 575126 PE
D 505 530/30 FITC, Alexa Fluor® 488

E Blank 488/10 SSC
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Five-color blue laser The following map shows the five-color configuration for the
configuration 488-nm blue laser.
PMT LP mirror BP filter Fluorochromes

A 750 780/60 PE-Cy7

B 685 695/40 PerCP-CyS.5

C 600 610/20 PE-Texas Red®

D 550 575126 PE

E 505 530/30 FITC,

Alexa Fluor® 488

F Blank 488/10 SSC




Six-color blue laser
configuration
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The following map shows the six-color configuration for the

488-nm blue laser.

PMT

A
B
C
D
E
F
G

LP mirror

750
685
655
600
550
505
Blank

BP filter
780/60

695/40
670/30
610/20
575726
530/30
488/10

Fluorochromes

PE-Cy7

PerCP-CyS.5

PE-CyS

PE-Texas Red®

PE

FITC, Alexa Fluor® 488
SSC




142 | BD LSRFortessa Cell Analyzer User's Guide

Two-color red trigon The following map shows the two-color configuration for
configuration the 640-nm red laser.
PMT LP mirror BP filter Fluorochromes
A 750 780/60 APC-Cy7, APC-H7

B Blank 670/14 APC
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Three-color red laser The following map shows the three-color configuration for
configuration the 640-nm red laser.
PMT LP mirror BP filter Fluorochromes
A 750 780/60 APC-Cy7, APC-H7
710 730/45 Alexa Fluor® 700

C — 670/14 APC
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Four-color red laser The following map shows the four-color configuration for
configuration the 640-nm red laser.
PMT LP mirror BP filter Fluorochromes
A 750 780/60 APC-Cy7, APC-H7
B 710 730/45 Alexa Fluor® 700
C 675 685/35 Alexa Fluor® 680
D — 670/14 APC
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Two-color violet laser The following map shows the two-color configuration for
configuration the 405-nm violet laser.

PMT LP mirror BP filter = Fluorochromes

A 475 525/50 | AmCyan, Qdot 525,
BD Horizon™ V500
B Blank 450/50 | Pacific Blue™,

BD Horizon™ V450,
Marina Blue®,
Alexa Fluor® 405
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Three-color violet laser ~ The following map shows the three-color configuration for
configuration the 405-nm violet laser.

PMT LP mirror BP filter = Fluorochromes

A 595 605/12 Qdot 605
475 525/50 AmCyan, V500, Qdot 525
C — 450/50 Pacific Blue™, V450,

Marina Blue®,
Alexa Fluor® 405
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Six-color violet octagon  The following map shows the six-color configuration for the
405-nm violet laser.

PMT LP mirror BP filter Fluorochromes

A 630 655/8 Qdot 655

B 595 605/12 | Qdot 605

C 575 585/15 | Qdot 585

D 545 560/20 | Qdot 565

E 475 525/50 | AmCyan, V500, Qdot 525
F Blank 450/50 | Pacific Blue™, V450,

Marina Blue®,
Alexa Fluor® 405
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Two-color UV laser The following map shows the two-color configuration for
configuration the 355-nm UV laser.
PMT LP mirror BP filter =~ Fluorochromes
A 505 530/30 Indo-1 (Blue)
B Blank 450/50 Indo-1 (Violet), DAPI,
Alexa Fluor® 350

Related topics e About the base configuration (page 133)
e Special Order configurations (page 149)
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Special Order configurations

About this topic This topic describes some of the more common
configurations available through the Special Order Research
Program.

Available options The BD LSRFortessa cytometer can be configured with up to

5 lasers choosing from 11 different special order wavelength
options and a variety of detectors. This section shows some
of the common special order laser/detector combinations.
Contact your local BD Biosciences sales representative for
information about other configurations.

BP filters used with CS&T Not all combinations of Special Order BP filters and lasers
are normalized to CS&T settings. In this case, CS&T will
generate Qr and Br numbers that are not comparable from
instrument to instrument. Care should be taken when
interpreting the CS&T reported Qr values on Special Order
BD LSRFortessa instruments. Please see the latest published
filter guides available on our website (bdbiosciences.com) for
more information.

Blue 488 nm (20-100 mW) The fluorochromes listed in the following table can be used
with this laser wavelength for cell surface markers, live/dead
discrimination, and cell cycle applications. See Common blue
laser configurations (page 154) for common octagon and
trigon configuration maps.

Fluorochromes BP filters
SSC 488/10
FITC, Alexa Fluor® 488 530/30
PE 575125
575126
576126

585/42


http://www.bdbiosciences.com
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Fluorochromes BP filters
PE-Texas Red®, PI 610/20
616/23
PE-Cy5 660/20
670/30
PerCP, PerCP-Cy5.5, PE-Cy5.5 670/14
675/20
695/40
710/50
PE-Cy7 780/60

Red 640 nm (40 mW) The fluorochromes listed in the following table can be used
with this laser wavelength for the cell surface marker
application. See Common red laser configurations (page 156)
for two common trigon configuration maps.

Fluorochromes BP filters
APC, Alexa Fluor® 647 670/30
Alexa Fluor® 680 685/35
Alexa Fluor® 700 710/50
710/20
712/21
730/45

APC-Cy7, APC-H7 780/60



Violet 405 nm
(20-100 mW)

Chapter 9: Detector array configurations

The fluorochromes listed in the following table can be used
with this laser wavelength for cell surface marker, live/dead
discrimination, and cell cycle applications. See Common
violet laser configurations (page 157) for common octagon
and trigon configuration maps.

Fluorochromes BP filters
V450, Pacific Blue™ 450/50
450/40
450/20
440/40
AmCyan, Alexa Fluor® 430, V500, 510/50
DAPI 525/50
Qdot 525 NA
Qdot 545 NA
Qdot 565 560720
Qdot 585 585/15
Qdot 605 605/12
605/40
Qdot 655 655/8
Qdot 700 NA
Qdot 705 NA

Qdot 800 NA

151
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UV 355 nm (20-100 mW) The fluorochromes listed in the following table can be used
with this laser wavelength for the cell cycle application with
the DAPI and Hoechst fluorochromes. The wavelength is
used for the Ca*2 flux application with both Indo-1
fluorochromes. See Common UV laser configurations
(page 159) for two common trigon configuration maps.

Fluorochromes BP filters
DAPI, Hoechst 440/40
450/20
450/40
450/50
Indo-1 (Ca Bound) 450/50
Indo-1 (Ca unbound) 530/30
Yellow-Green 561 nm The fluorochromes listed in the following table can be used
(50 mw) with this laser wavelength for cell surface marker and

fluorescent protein applications. See Common yellow-green
laser configuration (page 161) for a common octagon
configuration map.

Fluorochromes BP filters
PE, DsRed 582/15
582/15
PE-Texas Red®, mCherry 610/20
PE-Cy5 660/20
670/30
PE-CyS5.5 710/50

PE-Cy7 780/60
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Green 532 nm (150 mW)  The fluorochromes listed in the following table can be used
with this laser wavelength for the cell surface markers
application. See Common green laser configuration
(page 162) for a common octagon configuration map.

Fluorochromes BP filters
PE 575125
PE-Texas Red® 610/20
PE-Cy5 660/20
670/30
PE-CyS.5 695/40
710/50

PE-Cy7 780/60
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Common blue laser
configurations

The following maps show two common configurations for
the 488-nm blue laser.

PerCP-Cy5.5

SsC

PE-Texas Red®
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Note that with the 488-nm blue laser, FITC requires a 525/
50 notch filter if the cytometer also uses a 532-nm laser.
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Common red laser The following maps show two common configurations for
configurations the 640-nm red laser.

Alexa Fluor® 700
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Common violet laser The following maps show two common configurations for
configurations the 405-nm violet laser.

V450 or Pacific Blue™
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Qdot 700 or
Qdot 705

dot 605

Qdot 656

AmCyan

V450 or
Pacific Blue™

Qdot 585

Qdot 800

Qdot 655
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Common UV laser The following maps show two common configurations for
configurations the 355-nm UV laser.

Indo-1 (violet)

Indo-1 (blue)
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Indo-1 (blue)

Hoechst Red
Indo-1 (violet)
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Common yellow-green The following map shows a common configuration for the
laser configuration 561-nm yellow-green laser.
PE-Cy5.5

PE-Texas Red®

PE-Cy5

Note that when you use a PE conjugate with a 561-nm laser,
you must replace the 585/42 bandpass filter (BP) with a 582/
15 BP, regardless of which laser (blue, green, or yellow-green)
is exciting the PE fluorochromes.
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Common green laser
configuration

The following map shows a common configuration for the
532-nm green laser.

PE-Cy5.5

PE-Cy5
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Manual settings

This section covers the following topics:
e About laser delay (page 164)
e Optimizing laser delay (page 165)

e Adjusting area scaling (page 168)
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About laser delay

About this topic

About laser signal delay

This topic describes how to manually set the laser delay if
you are not using Cytometer Setup and Tracking.

Sample interrogation takes place within the cuvette flow cell.
Laser light is directed through a series of prisms that focus
multiple lasers on the event stream at different positions.
This allows optimal detection of fluorescent signals from
each laser with minimal cross-contamination from the other
beams.

For example, in a BD LSRFortessa four-laser system, the blue
laser intercepts the stream first, followed by the violet, UV,
and red lasers. Because the laser signals are spatially
separated, there is a slight delay between the detection of
each laser’s signal.

Event intercepts yellow-green laser® ’ \
Event intercepts red laser Yellow-green
= Event intercepts UV laser f \
Event intercepts violet laser Red
Event intercepts blue laser {\
uv
‘ | Violet
{\i Blue
Time——>

*The yellow-green laser is only available through the BD Special Order Research Program.

The laser delay setting in BD FACSDiva software is used to
realign the signals so they can be measured and displayed on
the same time scale. Signals are aligned with respect to the
blue laser, so the blue laser will have a 0 delay value, and the
red laser will have the longest delay.
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Optimizing laser delay

About this topic This topic describes how to optimize the laser delay using
BD FACSDiva software.

Before you begin To optimize the delay for a given laser, you must acquire
events from a sample with a fluorescence signal excited by
that laser. Follow the procedures in Recording and analyzing
data (page 81), for sample optimization and acquiring data.

Procedure To optimize laser delay:

1. While acquiring data from your sample, create a
histogram to show the fluorescence signal excited by the
laser for which the delay is to be optimized.

2. In the Acquisition Dashboard, set the Events to Display
to 500 events.

3. Click the Laser tab in the Cytometer window.
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Window extension and laser delay values are displayed
in microseconds (ps).

4. Set the Window Extension value to 0 ps.

5. Set an initial laser delay value only for the laser you are
optimizing.

— If you are optimizing the violet laser, set its delay to
40 ps.

— If you are optimizing the UV laser, set its delay to
75 ps.

- If you are optimizing the red laser, set its delay to
110 ps.
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6. While observing the positive events on the histogram,
adjust the laser delay in 1-ps increments. You might need
to adjust the delay above or below the initial setting.

Choose the setting that moves the events farthest to the
right (highest fluorescence intensity).

7. Draw an interval gate on the histogram for the positive
events.

8. Create a statistics view to display the mean fluorescence
intensity (MFI) of the gated population.

9. While observing the MFI for the gated population,
adjust the laser delay in 0.1-ps increments within a range
of 2.0 ps of the setting obtained in step 6.

Preserve the setting that maximizes the fluorescence
intensity.

10. Reset the Window Extension to 10 ps.
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Adjusting area scaling

About this topic

About area scaling

About this example

Adjusting area scaling

This topic describes how to manually adjust the area scaling
on your cytometer if necessary for your application. The area
scaling is automatically set in CS&T. Depending on the size
of your target particle, you might need to adjust the area
scaling manually. Larger particles are more likely to require
an area scaling adjustment.

The area of a pulse is calculated by BD FACSDiva using
measured height and width measurements. It is sometimes
important to verify that the area calculation and the height
measurement are equivalent by adjusting the factor applied
to the area. The required area scaling factor changes based
on sheath pressure and particle size.

The following example describes how to adjust area scaling
for an experiment which uses only the 488-nm laser and the
640-nm laser. You must adjust area scaling for all lasers used
in your experiment. To adjust the other lasers, add a
parameter and the corresponding plots from that laser to the
procedure.

To adjust area scaling:
1. Open an existing experiment, or create a new
experiment in the Browser.

2. Create a new specimen by clicking the New Specimen
button on the Browser toolbar.
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In the Inspector, click the Parameters tab and select the
H checkbox to select height for each parameter.
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On the global worksheet, create the following plots and
histograms:

— FSC vs SSC dot plot

- FSC-H and FSC-A histogram

— FITC-H and FITC-A histogram
— APC-H and APC-A histogram

Create a P1 gate in the FSC vs SSC plot, and show only
the P1 population in all histograms.
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6. Create three statistic views showing the following:

— FSC-H and FSC-A means for P1

— FITC-H and FITC-A means for P1

— APC-H and APC-A means for P1

Your worksheet should look similar to the following
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7. Expand the new specimen, then set the current tube
pointer to tube_001.

8. Install the FITC-positive control tube onto the loading
port and click Load in the Acquisition Dashboard.

9. Adjust the FSC and SSC voltages to place the particles on
scale.

Specimen_001-Tuhe_001

55C-H (x 10007
150 o 240

|||I|||||||||||||||||||||||
a0 100 150 11} 250
FSi-H (= 1,000

10. Adjust the P1 gate around the population of interest.
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11. Adjust the FSC area scaling.

a. Click the Laser Tab in the Cytometer window.

Cytometer - Z5A100002 (LSRFartessa) (1)

Status | Parameters | Threshold |{Laser | Compensation | Ratio|

Mame Delay Area Scaling
Elue .00 0.75
Red 114.45 .56
(inlet .11 0.3
iy 75.17 .48

i 1000 =
FSC AreaScaing: | 0.59 2 f

I Cytometer Conmected

b. Adjust the FSC area scaling factor until the FSC-A
signal matches the FSC-H signal:

e Increase the area scaling factor if the FSC-A signal
is lower than FSC-H.

e Decrease the area scaling factor if the FSC-A
signal is higher than FSC-H.

c. View the result of your change in the histograms and
statistics views.

12. Adjust the blue laser area scaling factor until the FITC-A
signal matches the FITC-H signal, if needed.

13. Unload the FITC-positive control tube, then load the
APC-positive control tube.
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14. Adjust the red laser area scaling factor until the APC-A
signal matches the APC-H signal, if needed.

Specimen_001-Tube_001

Count

Iir””ﬁlﬂ““IqﬂI“J “lliliﬂ””

0 o 150 LEd 0
FSC-H (x 1.000)

Specimen 001-Tube 001

Count

[E11]

FSC-a (x 10000

Tube Name: Tube_001
Record Date; Dec 1, 2009 10:5748 Al

FSC-A FSC-H
Population Mean Kean |

Hri 68,989 68,339




Need more information fast?

Information about this product is also available in your
software's Help system.

You can keep the Help window open while you use the
software or print the information directly from the window.

Internet access is not required to use the Help system.
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Supplies and consumables

This chapter covers the following topics:
e Ordering information (page 176)

e DParticles (page 177)

e Reagents (page 178)

e Equipment (page 179)
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Ordering information

To order spare parts and consumables from BD Biosciences:

e  Within the US, call (877) 232-8995.

e Outside the US, contact your local BD Biosciences
customer support representative.

Worldwide contact information can be found at
bdbiosciences.com.



http://www.bdbiosciences.com
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Particles
About this topic This topic lists the QC and CS&T particles available.
QC particles
Particle Laser Supplier Catalog No.
SPHERO™ Rainbow All BD Biosciences | 559123
Calibration Particles (8 peaks)
SPHERO Ultra Rainbow All Spherotech, Inc. | URFP-30-2
Fluorescent Particles (single
peak)
DNA QC Particles kit Blue (488 nm) BD Biosciences 349523
CS&T particles
Particle Laser Supplier Catalog No.

BD Cytometer Setup and e UV (355 nm and 375 nm) BD Biosciences = e 641319

Tracking (CS&T) beads Violet (405 nm) (1 vial)
e Blue (488 nm) ¢ (6;%::152)

e Red (640 nm)
e Yellow-green (561 nm)
o Green (532 nm)
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Reagents

Reagent Supplier Catalog No.
BD FACSFlow sheath fluid BD Biosciences 342003
BD FACS sheath solution with BD Biosciences 336524

surfactant (recommended for use
with the HTS option)

Monoclonal antibodies BD Biosciences See the BD Biosciences
Product Catalog or the
BD Biosciences website

(bdbiosciences.com)

BD FACS™ lysing solution BD Biosciences 349202
BD FACSRinse solution BD Biosciences 340346
BD FACSClean solution BD Biosciences 340345
Dyes and fluorochromes BD Biosciences, Molecular -

Probes, or Sigma

Chlorine bleach Clorox or other major -
(5% sodium hypochlorite) supplier (to ensure that the

bleach is at the correct

concentration and free of

particulate matter)



http://www.bdbiosciences.com

Chapter 11: Supplies and consumables | 179

Equipment
Equipment item Supplier Catalog No.
Bal seal BD Biosciences 343509
O-ring, sample tube 343615
Sheath filter assembly 345743
BD Falcon polystyrene 352052
test tubes, 12 x 75-mm 352054

352058




Need more information fast?

Information about this product is also available in your
software's Help system.

You can keep the Help window open while you use the
software or print the information directly from the window.

Internet access is not required to use the Help system.
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Numerics

355-nm UV laser
405-nm violet laser
488-nm blue laser
532-nm green laser 153, 162
561-nm yellow-green laser 152, 161
640-nm red laser 142-144,150, 156

148,152, 159
145-147, 151, 157
139-141, 149, 154

A

acridine orange (AO) 41
air bubbles, removing 28
alarm
battery test 46
waste container 17
analysis
data 82
immunophenotyping 88
reusing 94
saving 94
antibodies 101
AO See acridine orange
application settings
applying 84
creating 73
area scaling 168
arm, tube support 15
aspiration (sample), rapid 117
assistance, technical 7

Bal seal
ordering 179
replacing 52
bandpass (BP) filters
detector array placement 20
holder 34
theory 106
base configurations 138
battery
changing 47
test 46
BD FACSClean solution 178
BD FACSDiva software See software
BD FACSFlow sheath fluid 178
BD FACSFlow solution 27
BD FACSFlow supply system 24, 43
BD FACSRinse solution 42
BD Falcon tubes 179
BD High Throughput Sampler (HTS) 16
blank optical holders 35
bleach 40, 178
blue 488-nm laser 139-141, 149, 154
BP See bandpass filters
bubbles, removing air 28
buttons
fluid control 14
sample flow rate control 13
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C

calculating compensation 80
capacity, waste container 17
cleaning solutions 40
compensation
calculating 80
control tubes 76
recording settings 77
theory 108
components
cytometer shown 11
sheath container shown 26
sheath filter shown 50
waste container shown 31
computer system, about 21
configuration
base 133
BD FACSDiva 61
maps 132
containers
sheath 17,26
waste 17, 30, 32
control panel, cytometer 12
controls
fluidics 12
single-stained 60, 82

conventions
keyboard 4
safety symbols 3
text 4

creating

analysis objects 88
global worksheets 83
statistics view 88
CS&T particles 177
cuvette flow cell 164
CV, troubleshooting 125
cytometer 10
components shown 11
configuration 35, 61

disconnect error 127
door and drawer 36
setup S8

starting 24
troubleshooting 116

D

DAPI, cleaning after using 41
data

analyzing 82, 88

gating 88

recording 82, 85
debris, excessive 124
default configuration 133
delay, laser 164
detector arrays 18
detectors 20
dichroic mirrors

slots 34

theory 107
digital data 10
digital electronics 113
Diva software See software
DNA, flow rate for analysis 99
droplet containment system 16

E

electronics

digital 113

laser controls 114

pulse 111

pulse measurements 112

threshold 113

troubleshooting 127
emission duration 111
event rate

erratic 123

high 121

low 122
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zero 117,119 removing air bubbles 28
excessive debris 124 run mode 14
excitation wavelength 101 sample injection port (SIP) 15
experiments fluidics controls, cytometer 12
creating 69 fluidics interconnect 29
immunophenotyping 83 fluorescence
sample optimization 69 defined 101
specifying parameters 70 emission 111
fluorescence signal, none 120
F fluorochromes

compensation theory 108

emission spectra 102

measured 35

role in light emission 101
flushing the system 44
forward scatter (FSC) 100
FSC See forward scatter

FACSFlow sheath fluid 178
FACSFlow solution 27
Falcon tubes 117,179
filters, optical
bandpass (BP) 20, 106
changing 36
dichroic See dichroic mirrors
longpass (LP) 103, 104

notch 104, 155 G
shortpass (SP) 103, 105 gating data 88
slots 34 global worksheets
theory 103 analyzing data 88
filters, sheath creating 83
attaching new 51 previewing data 82, 94
replacing 50 green 532-nm laser 153, 162
FITC and Stokes shift 101
fixed-alignment lasers 10 H
flow cell

hazard symbol definitions 3

Help, accessing 5

High Throughput Sampler (HTS) 16
hydrodynamic focusing 98

draining 33

fluidics 98
flow rate control buttons 13
fluid control buttons

PRIME 14

RUN 14 |
STNDBY 14 immunophenotyping
fluidics analysis 88
description 13, 98 experiment 83
flow rate control 13 hydrodynamic focusing 99

flushing system 44
priming 33
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K

keyboard conventions 4

knob, SAMPLE FINE ADJ 13

L

laser delay
about 164
optimizing 165
lasers
options 19
performance check 64

quality control (QC) particles 177

longpass (LP) filters
defined 103
holder 34
theory 104

LP See longpass filters

M

maintenance
Bal seal 52
battery change 47
battery test 46
cytometer shutdown 43
sample tube O-ring 54
schedule 41
scheduled 44
sheath filter 50
system flush 44
waste management system 46
mirrors, dichroic longpass (LP) filter

N
notch filters 104, 155

o

octagon
configuration maps 132

detector 10
location 36
shown 20
online Help 5
optic holder 35
optics
components 18
configuration 61, 62
dichroic mirrors 107
filters 19, 36, 103
location 11
optimization, sample 58
ordering spare parts 176
O-ring
ordering 179
replacing 54
worn 116

P

particles 177
PerCP, Stokes shift 101
performance check 64, 65
photodiode 20
photomultiplier tubes (PMTs) 20
PMT See photomultiplier tubes
population hierarchy 88
power switch 11, 12
PRIME, fluid control button 14
priming fluidics system 33
propidium iodide (PI) 41
pulse
definition 111
measurements 112
processors 112

Q

quality control (QC)
particles 177
troubleshooting 125
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R saving analyses 94
recording scatter
compensation settings 77 light 100

compensation tubes 76 parameter distortion 123

data 82, 85 setup, cytometer 58
red 640-nm laser  142-144, 150, 156 sheath
removing air bubbles, filter 28 flow 98
replacing pressure 98
Bal seal 52 sheath container
battery 47 components shown 26
defined 17

optical filters 36 .
sample tube O-ring 54 dePfCSSHHZf? 27
sheath filter 50 preparing 27
waste air filter 49 sheath filter

reusing analyses 94 components shown 50

rinsing solution 42 Ofdefif.lg 179
RUN removing air bubbles 28

replacing 50
sheath fluid 98
backflush 16
BD FACSFlow sheath fluid 178

button orange 119
fluid control button 14

5 shortpass (SP) filters 103, 105
safety symbols 3 side scatter (SSC) 100
sample signals, amplifying 20
optimization 58 SIP See sample injection port
optimization experiment 69 software
optimization, single-stained cytometer control 2
controls 60, 82 version 21
SAMPLE FINE ADJ knob 13 Spare parts, ordering 176
sample injection port (SIP) spillover 108
components 15 SSC See side scatter
hydrodynamic focusing 98 starting cytometer 24
location 11 statistics views 88
replacing Bal seal 52 STNDBY, fluid control button 14
replacing sample tube O-ring 54 Stokes shift 101
sample tube support, technical 7
injection 15
not fitting 117 T

requirements 117

samples, running 85 technical assistance 7

testing battery 46
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text conventions 4 Y
thiazole orange (TO) 41
threshold, defined 113
TO See thiazole orange
trigon
configuration maps 132
detector 10
location 36
troubleshooting
cytometer 116
electronics 127
tubes
Falcon 117,179
requirements 117

yellow-green 561-nm laser 152, 161

U

user preferences 62
UV 355-nm laser 148,152,159

\')
violet 405-nm laser 145-147,151, 157

W

waste air filter
component shown 31
replacing 49

waste air vent filter
replacing 119

waste container 17
alarm 17
battery test 46
capacity 17
components shown 31
defined 17
emptying 30
pressurized 32,119
replacing battery 47

window extension 166

workstation, about 21
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